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Introduction

This guide describes the Pipe Flow Module, an optional add-on package for
COMSOL Multiphysics® designed to model and simulate incompressible and
weakly compressible flow, heat, and mass transfer in pipes and channels with the
Pipe Flow features. Compressible hydraulic transients and acoustics waves can also
be modeled using the Water Hammer features and Pipe Acoustics features,
respectively. To analyze the stresses and deformation in the pipes, the Pipe
Mechanics interface is available. The Pipe Flow Module can address problems
involving flow velocity, pressure, temperature, stresses, deformation and sound
waves in cooling systems, ventilation systems, pipe systems in the chemical

processing industry, and lines in the oil and gas industry.

This chapter introduces you to the capabilities of this module. A summary of the
physics interfaces and where you can find documentation and model examples is
also included. The last section is a brief overview with links to each chapter in this

guide.



About the Pipe Flow Module

What Can the Pipe Flow Module Do?

The Pipe Flow Module is intended for the modeling and simulation of flow of fluids
in the pipes and channel systems, as well as compressible hydraulic transients and
acoustics waves. Typical simulations yield the velocity, pressure variation, and
temperature in systems of pipes and channels. Hydraulic transients resulting from a
valve that is closed rapidly in a pipe network is referred to as water hammer, which can
be modeled too. This module has extra functionality for computing displacements,
rotations, stresses, and strains in the pipes. The module can be used to design and
optimize complex cooling systems in turbines, ventilation systems in buildings, pipe

systems in chemical processes, and lines in the oil and gas industry.

In common for pipes and channels that can be modeled using the Pipe Flow Module
is that the pipe length is large enough so that the flow inside can be considered fully
developed. Piping components such as bends, valves, T-junctions, contractions/

expansions, and pumps are also available in the module.
The Pipe Flow Module includes these physics interfaces:

e The Pipe Flow interface computes the pressure and velocity field in isothermal pipe

systems.

e The Heat Transfer in Pipesinterface computes the energy balance in pipe systems
but receives the flow field as a value or as a known solved field. Wall heat transfer to

the surroundings is included.

e The Transport of Diluted Species in Pipesinterface solves a mass balance equation
for pipes in order to compute the concentration distribution of a solute in a dilute

solution, considering diffusion, dispersion, convection, and chemical reactions.

e The Nonisothermal Pipe Flow interface is a multiphysics interface that solves the

flow, pressure, and temperature simultaneously and fully coupled.

e The Reacting Pipe Flow interface is a multiphysics interface that solves the flow,
pressure, temperature, and reacting species transport simultaneously and fully
coupled.

e The Water Hammer interface solves rapid hydraulic transients in pipe systems,
taking the elastic properties of both the fluid and pipe wall into account.

8 | CHAPTER |: INTRODUCTION



* The Pipe Acoustics, Frequency Domain interface models sound waves in flexible

pipe systems, with the assumption of harmonic vibrations.

e The Pipe Acoustics, Transient interface models sound waves in flexible pipe systems

with arbitrary transient variations in pressure.

* The Pipe Mechanics interface analyzes the stresses and deformations in pipes.

o The Fluid-Pipe Interaction, Fixed Geometry interface can be used to model

problems where the forces from the fluid in a piping system act as structural loads.

The physics interfaces in the module define the conservation of momentum, energy,
and mass of a fluid inside a pipe or channel system. The flow, pressure, temperature,
and concentration fields across the pipe cross sections are modeled as cross-section
averaged quantities, which only vary along the length of the pipes and channels. The
pressure losses along the length of a pipe or in a pipe component are described using
friction factor expressions. A broad range of built-in expressions for Darcy friction
factors cover the entire flow regime from laminar to turbulent flow, Newtonian and
non-Newtonian fluids, different cross-sectional geometries, and a wide range of
relative surface roughness values. In addition to the continuous frictional pressure
drop along pipe stretches, pressure drops due to momentum changes in components
such as bends, contractions, expansions, T-junctions and valves are computed through
an extensive library of industry standard loss coefficients. Pumps are also available as
components.

Building a COMSOL Multiphysics Model in the COMSOL Multiphysics
E}‘ Reference Manual

The Pipe Flow Module Physics Interface Guide

The Pipe Flow Module extends the functionality of the physics interfaces of the base
package for COMSOL Multiphysics. The details of the physics interfaces and study
types for the Pipe Flow Module are listed in the table. The functionality of the

ABOUT THE PIPE FLOW MODULE



COMSOL Multiphysics base package is given in the COMSOL Multiphysics
Reference Manual.

In the COMSOL Multiphysics Reference Manual:

e Studies and Solvers
'El * The Physics Interfaces
* For a list of all the core physics interfaces included with a COMSOL

Multiphysics license, see Physics Interface Guide.

PHYSICS INTERFACE ICON |[TAG SPACE AVAILABLE STUDY TYPE
DIMENSION

1)) Acoustics

Q) Pipe Acoustics

Pipe Acoustics, ]| pafd 3D, 2D eigenfrequency; frequency
Frequency Domain domain

Pipe Acoustics, (b |patd 3D, 2D time dependent
Transient

¢:2 Chemical Species Transport

Reacting Pipe Flow S [rpfl 3D, 2D stationary; time dependent
Transport of Diluted Sy |dsp 3D, 2D stationary; time dependent
Species in Pipes
= Fluid Flow
== Single-Phase Flow
Pipe Flow S |pfl 3D, 2D stationary; time dependent
Woater Hammer @] whtd 3D, 2D time dependent

10 | CHAPTER I: INTRODUCTION



PHYSICS INTERFACE ICON |TAG SPACE AVAILABLE STUDY TYPE
DIMENSION

== Nonisothermal Flow

Nonisothermal Pipe 5 nipfl 3D, 2D stationary; time dependent

Flow

Fluid-Structure Interaction
Fluid-Pipe Interaction, g(g, — 3D, 2D stationary; time dependent
Fixed Geometry
Heat Transfer

Heat Transfer in Pipes htp 3D, 2D stationary; time dependent
&1 Structural Mechanics
Pipe Mechanics 2 pipem 3D, 2D stationary; eigenfrequency;

time dependent, modal;
time dependent, modal
reduced-order model;
frequency domain;
frequency domain, modal;
frequency domain, modal
reduced-order model; time
dependent; response
spectrum; random
vibration (PSD)

Common Physics Interface and Feature Settings and Nodes

There are several common settings and sections available for the physics interfaces and
feature nodes. Some of these sections also have similar settings or are implemented in

the same way no matter the physics interface or feature being used. There are also some

physics feature nodes that display in COMSOL Multiphysics.

ABOUT THE PIPE FLOW MODULE
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In each module’s documentation, only unique or extra information is included,
standard information and procedures are centralized in the COMSOL Multiphysics
Reference Manual.

In the COMSOL Multiphysics Reference Manual see Table 2-4 for
links to common sections and Table 2-5 to common feature nodes.
n You can also search for information: press F1 to open the Help

window or Ctrl+F1 to open the Documentation window.

The Liquids and Gases Materials Database

The Pipe Flow Module includes an additional Liquids and Gases material database with

temperature-dependent fluid dynamic and thermal properties.

For detailed information about materials and the Liquids and Gases
El" Materials Library, see Materials in the COMSOL Multiphysics Reference
Manual.

CHAPTER I:

Where Do I Access the Documentation and Application Libraries?

A number of internet resources have more information about COMSOL, including
licensing and technical information. The electronic documentation, topic-based (or
context-based) help, and the application libraries are all accessed through the
COMSOL Desktop.

Ifyou are reading the documentation as a PDF file on your computer,
the blue links do not work to open an application or content

n referenced in a different guide. However, if you are using the Help
system in COMSOL Multiphysics, these links work to open other

modules, application examples, and documentation sets.

THE DOCUMENTATION AND ONLINE HELP

The COMSOL Multiphysics Reference Manual describes the core physics interfaces
and functionality included with the COMSOL Multiphysics license. This book also has
instructions about how to use COMSOL Multiphysics and how to access the

electronic Documentation and Help content.

INTRODUCTION



Opening Topic-Based Help

The Help window is useful as it is connected to the features in the COMSOL Desktop.
To learn more about a node in the Model Builder, or a window on the Desktop, click
to highlight a node or window, then press F1 to open the Help window, which then
displays information about that feature (or click a node in the Model Builder followed
by the Help button ( [@ ). This is called zopic-based (or context) help.

To open the Help window:

¢ In the Model Builder, Application Builder, or Physics Builder click a node or

window and then press F1.

* On any toolbar (for example, Home, Definitions, or Geometry), hover the
Win mouse over a button (for example, Add Physics or Build All) and then
press F1.
* From the File menu, click Help ( | )-
* Inthe upper-right corner of the COMSOL Desktop, click the Help ( [ )
button.

To open the Help window:

¢ In the Model Builder or Physics Builder click a node or window and then
press F1.

¢ On the main toolbar, click the Help ( g ) button.

¢ From the main menu, select Help>Help.

Opening the Documentation Window

To open the Documentation window:

Win ¢ Press Ctrl+F1.

¢ From the File menu sclect Help>Documentation ( I!| ).

ABOUT THE PIPE FLOW MODULE
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To open the Documentation window:

e DPress Ctrl+F1.

* On the main toolbar, click the Documentation ( u ) button.

¢ From the main menu, select Help>Documentation.

THE APPLICATION LIBRARIES WINDOW

Each model or application includes documentation with the theoretical background
and step-by-step instructions to create a model or application. The models and
applications are available in COMSOL Multiphysics as MPH files that you can open
for further investigation. You can use the step-by-step instructions and the actual
models as templates for your own modeling. In most models, SI units are used to
describe the relevant properties, parameters, and dimensions, but other unit systems
are available.

Once the Application Libraries window is opened, you can search by name or browse
under a module folder name. Click to view a summary of the model or application and

its properties, including options to open it or its associated PDF document.

The Application Libraries Window in the COMSOL Multiphysics
'El Reference Manual.

Opening the Application Libraries Window
To open the Application Libraries window ([[[]] ):

¢ From the Home toolbar, Windows menu, click ([m] ) Applications
Libraries.
Win * From the File menu select Application Libraries.
To include the latest versions of model examples, from the File>Help
menu, select (] ) Update COMSOL Application Library.

To include the latest versions of model examples, from the Help menu

Select Application Libraries from the main File> or Windows> menus.

Linux select ([li ) Update COMSOL Application Library.

14 | CHAPTER I: INTRODUCTION



CONTACTING COMSOL BY EMAIL

For general product information, contact COMSOL at info@comsol.com.

COMSOL ACCESS AND TECHNICAL SUPPORT

To receive technical support from COMSOL for the COMSOL products, please
contact your local COMSOL representative or send your questions to

support@comsol.com. An automatic notification and a case number are sent to you by

email. You can also access technical support, software updates, license information, and
other resources by registering for a COMSOL Access account.

COMSOL ONLINE RESOURCES

COMSOL website
Contact COMSOL
COMSOL Access
Support Center
Product Download
Product Updates
COMSOL Blog
Discussion Forum
Events

COMSOL Application Gallery
COMSOL Video Gallery

Support Knowledge Base

www.comsol.com
www.comsol.com/contact
www.comsol.com /access
www.comsol.com/support
www.comsol.com/product-download
www.comsol.com/support/updates
www.comsol.com/blogs
www.comsol.com,/community
www.comsol.com/events
www.comsol.com/models
www.comsol.com/video

www.comsol.com /support/knowledgebase

ABOUT THE PIPE FLOW MODULE
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Overview of the User’s Guide

The Pipe Flow Module User’s Guide gets you started with modeling using COMSOL
Multiphysics. The information in this guide is specific to this module. Instructions how
to use COMSOL in general are included with the COMSOL Multiphysics Reference
Manual.

As detailed in the section Where Do I Access the Documentation and
Application Libraries? this information can also be searched from the
COMSOL Multiphysics software Help menu.

CHAPTER I:

TABLE OF CONTENTS AND INDEX

To help you navigate through this guide, see the Contents and Index.

THE FLUID FLOW BRANCH

The Fluid Flow Interfaces chapter describes the Pipe Flow interface and the
Nonisothermal Pipe Flow interface including the underlying theory for these physics
interfaces.

THE HEAT TRANSFER BRANCH
The Heat Transfer Interfaces chapter describes the Heat Transfer in Pipes interface and
the underlying theory for the physics interface.

THE CHEMICAL SPECIES TRANSPORT BRANCH
The Chemical Species Transport Interfaces chapter describes the Transport of Diluted
Species in Pipes and the Reacting Pipe Flow interfaces and the underlying theory.

THE ACOUSTICS BRANCH

The Acoustics Interfaces chapter describes the Pipe Acoustics, Transient interface and
its theory.

THE STRUCTURAL MECHANICS BRANCH
The Pipe Mechanics chapter describes the Pipe Mechanics interface.

INTRODUCTION



THE MULTIPHYSICS COUPLINGS

The Multiphysics Couplings chapter describes the multiphysics couplings available
with the Pipe Flow Module. These are the built-in conditions that couple physics
together.

OVERVIEW OF THE USER'S GUIDE | 17
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Fluid Flow Interfaces

This chapter has information about the physics interfaces in the Pipe Flow Module
found under the Fluid Flow branch ().

Mechanisms for Modeling Fluid Flow
The Pipe Flow Interface

The Nonisothermal Pipe Flow Interface
The Water Hammer Interface

Theory for the Pipe Flow Interface

Theory for the Water Hammer Interface

See The Single-Phase Flow, Laminar Flow Interface in the COMSOL Multiphysics
Reference Manual for other Fluid Flow interface and feature node settings.



20 |

CHAPTER 2:

Mechanisms for Modeling Fluid Flow

The Fluid Flow branch (= )has a number of subbranches to describe momentum
transport. The main focus of this physics area is to model fluids transported in pipe
networks in 2D and 3D space, calculating velocity, flow rate, and pressure drops. Pipe
flow including heat and mass transfer can also be modeled.

The Pipe Flow Interface (5.), found under the Single-Phase Flow branch (=) when
adding a physics interface, is used to model incompressible and weakly compressible
fluid flow in piping systems. The equations that are solved are 1D equations that live

on 2D boundary segments or 3D edge segments.

The Nonisothermal Pipe Flow Interface (5. ), found under the Nonisothermal Flow
branch (=) when adding a physics interface, solves a temperature equation together

with the equations for compressible flow.

The Water Hammer Interface (i(0)), found under the Fluid Flow>Single-Phase Flow
branch (=) when adding a physics interface, has the equations and boundary

conditions for modeling rapid pressure transients in a pipe systems.

Coupling to Other Physics Interfaces

Itis often be relevant to couple flow and transport in pipes or pipe networks to physical
processes occurring outside the pipe network itself. For instance, liquid can be injected
into the surrounding by means of perforated pipes. The Pipe Flow interface can
calculate flow rates and pressure drops in a 1D representation in the injection system.
The equations can then be coupled to a Fluid Flow interface describing fluid flow in
2D or 3D geometries. Another important coupling that is prepared in the Pipe Flow
module is the Wall Heat Transfer feature that couples the temperature in a pipe to the

temperature in a 3D surrounding.

More advanced descriptions 2D and 3D continuum fluid flow, such as turbulent and
multiphase flow, can be found in the CED Module. More extensive descriptions of heat
transfer, such as in turbulent flow or involving radiation, can be found in the Heat
Transfer Module. Furthermore, some applications involving the flow of liquids and
gases in porous media are better handled by the Chemical Reaction Engineering
Module.

FLUID FLOW INTERFACES



The Pipe Flow Interface

The Pipe Flow (pfl) interface (5. ), found under the Single-Phase Flow branch (

when adding a physics interface, is used to compute the velocity and pressure fields in
pipes and channels of different shapes. It approximates the pipe flow profiles flow by
1D assumptions in curve segments, or lines. These lines can be drawn in 2D or 3D and
represent simplifications of hollow tubes. The interface is available in 3D on edges, and

in 2D on boundaries.

When this physics interface is added, these default nodes are also added to the Model
Builder — Fluid Properties, Pipe Properties, Pressure, Lossless Fitting and Initial Values.
Then, from the Physics toolbar, add other nodes that implement, for example,
boundary conditions and volume forces. You can also right-click Pipe Flow to select

physics features from the context menu.

SETTINGS

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers, and

underscores (_) are permitted in the Name field. The first character must be a letter.
The default Name (for the first physics interface in the model) is pf1.

FLUID MODEL

Select a Fluid model — Newtonian (the default), Power Law, Bingham, or Herschel-Bulkley.

For Newtonian sclect Single phase (the default), Gas-Liquid, friction factor multiplier, or

Gas-Liquid, effective Reynolds number.

When Gas-Liquid, friction factor multiplier or Gas-Liquid, effective Reynolds number arc
selected, the Phase Fractions node is automatically added as a default node. Selecting
these options also enables the choice of Liquid material and Gas material for the Fluid
Properties node.

For more information about the fluid models, see the section Theory for the Pipe Flow
Interface.

THE PIPE FLOW INTERFACE | 2I



DEPENDENT VARIABLES

This section defines the dependent variables (fields). If required, edit the name, but
dependent variables must be unique within a model:

* Pressure p (SI unit: Pa)

¢ Tangential velocity u (SI unit: m/s)

DISCRETIZATION
The default discretization for Pipe Flow interface is Linear — that is, piecewise linear

interpolation for tangential velocity and pressure.

FURTHER READING

* For an explanation of the tangential velocity, see Theory for the Pipe
Flow Interface.

@l * Edge, Boundary, Point, and Pair Nodes for the Pipe Flow Interface

* Theory for the Pipe Flow Interface

* Discharging Tank: Application Library path Pipe_Flow_Module/
Tutorials/discharging_tank

Convective Flow in o Heat Exchanger Plate: Application Library path
Pipe_Flow_Module/Tutorials/heat_exchanger_plate

Edge, Boundary, Point, and Pair Nodes for the Pipe Flow Interface

The Pipe Flow Interface has these boundary, edge, point, and pair nodes, listed in
alphabetical order, available from the Physics ribbon toolbar (Windows users), Physics
context menu (Mac or Linux users), or right-click to access the context menu (all

users).

In general, to add a node, go to the Physics toolbar, no matter what
operating system you are using. Subnodes are available by clicking the

parent node and selecting it from the Attributes menu.

22 | CHAPTER 2: FLUID FLOW INTERFACES



* Bend * The Nonisothermal Pipe Flow

* Contraction/Expansion Interface

¢ Fluid Properties * Pipe Properties

. I
e Initial Values Pressure

e Inlet * Pump

e Internal Pressure Lock * T-Junction

¢ No Flow e Valve
e n-Way Junction * Volume Force
e Qutlet e Y-Junction

e PDhase Fractions * Lossless Fitting

In the COMSOL Multiphysics Reference Manualsee Table 2-4 for links
to common sections and Table 2-5 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

Fluid Properties

The Fluid Properties node is always present and adds the momentum and mass balance
equations solved by the physics interface. If volume forces are needed in the model,
they should be added by a Volume Force node. The node also provides settings for
defining the material properties of the fluid. If a Liquid-Gas option is selected in the
Pipe Flow node settings, properties for both liquid and gas can be entered here.

FLUID PROPERTIES
This subsection displays when Newtonian>Single phase is sclected as the Fluid model for

the Pipe Flow interface.

The default Density p (ST unit: kg/ms) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity £ (ST unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick

(such as oil) have a higher viscosity.

THE PIPE FLOW INTERFACE
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LIQUID PROPERTIES
This section displays when Newtonian is selected as the Fluid model for the Pipe Flow
interface and then Gas-Liquid, friction factor multiplier or Gas-Liquid, effective Reynolds

number are also chosen.

Select the Liquid material — Edge material (3D components) or Boundary material (2D
components). If you have more than one material added to the model, you can toggle

this setting between the different designated materials.

The default Density o, (ST unit: kg/ m3) uses the value From material. You can change

this to User defined to enter a different value or expression.

The default Dynamic viscosity g, (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick

(such as oil) have a higher viscosity.

GAS PROPERTIES
This section displays when Newtonian is selected as the Fluid model for the Pipe Flow
interface and then Gas-Liquid, friction factor multiplier or Gas-Liquid, effective Reynolds

number are also chosen.

Select the Gas material — Edge material (3D components) or Boundary material (2D
components). If you have more than one material added to the model, you can toggle
this setting between the different designated materials.

The default Density pg (SI unit: kg/m3) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity g (SI unit: Pa-s) uses the value From material and

describes the relationship between the shear rate and shear stresses in a fluid.

MIXTURE VISCOSITY MODEL
This section displays only when Newtonian is selected as the Fluid model for the Pipe

Flow interface and the Gas-Liquid, effective Reynolds number is also chosen.

The default is the Extended Einstein which is considered the most accurate method for
a large range of gas fractions. The list of options include

¢ Extended Einstein (default)

e Linear average

* Reciprocal average
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* Liquid viscosity
e User defined

For details, please refer to the theory section Newtonian Fluids.

Volume Force

The Volume Force node specifies the volume force F on the right-hand side of the flow

equation. Use it, for example, to incorporate the effects of gravity in a model.

If several volume force nodes are added to the same domain, then the sum of all

contributions are added to the momentum equations.

VOLUME FORCE
Enter the components of the Volume force F' (SI unit: N/ms).

Pipe Properties

The Pipe Properties node is used to define the pipe shape, flow resistance, and surface

roughness.

PIPE SHAPE

Select a pipe shape from the list — Not set (the default), Circular, Square, Rectangular,
Concentric circular annular, or User defined.

* For Circular enter a value or expression for the Inner diameter d; (SI unit: m). The
default is 10 cm.

* For Square enter a value or expression for the Inner width w; (SI unit: m). The

default is 5 cm.
* For Rectangular enter a value or expression for the Inner width w; (SI unit: m. The
default is 5 cm) and Inner height &; (SI unit: m. The default is 10 cm).

* For Concentric circular annular enter a value or expression for the Inner diameter,
outer pipe d; ;¢ (SI unit: m. The default is 10 cm) and Outer diameter, inner pipe
dyp, inner(SI unit: m. The default is 0 cm).

¢ For User defined enter a value or expression for the Cross-sectional area A, (SI unit:
m? ). The defaultis 0.01 m?. Enter the Wetted perimeter Z (ST unit: m). The default
is 0.4 m.
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FLOW RESISTANCE

Select a Friction model.

Newtonian Fluids
Select Churchill (the default), Stokes, Wood, Haaland, Colebrook, Von Karman,

Swamee-Jain, or User defined.

* For Churchill, Wood, Haaland, Von Karman, or Swamee-Jain go to the Surface
Roughness section to select from a list of predefined values. Alternatively, enter

values or expressions.

¢ For User defined enter a value or expression for the Darcy friction factor f1

(dimensionless).

Non-Newtonian Fluids
For Non-Newtonian fluids in tubes of circular cross section the following friction

models are available:
For Power-law fluids, the Irvine, Stokes, and User defined options are available.
For Bingham fluids, the Darby, and User defined options are available.

For Herschel-Bulkley fluids, the Swamee-Aggarwal, and User defined options are

available.

For Non-Newtonian fluids in tubes of non-circular cross section, enter a value or

expression for the Darcy friction factor fp(dimensionless).

For more information about the friction models, see Expressions for the Darcy Friction

Factor.

SURFACE ROUGHNESS

This section is available if Churchill, Wood, Haaland, Von Karman, or Swamee-Jain is

selected as the Friction model.

Select a Surface roughness from the list — Smooth (0 mm), Drawn tubing (0.0015 mm)
(the default), Glass (0.0015 mm), Thermoplastics (0.0015 mm), Commercial steel (0.046
mm), Wrought iron (0.046 mm), Steel welded seamless (0.061 mm), Asphalted cast iron
(0.12 mm), Galvanized iron (0.15 mm), Cast iron (0.26 mm), Wood stave (0.5 mm), Copper

and brass (0.61 mm), Concrete (1.5 mm), Riveted steel (4.5 mm), or User defined.

For User defined enter a value or expression for the Roughness (SI unit: m).
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Phase Fractions

This node is available when Newtonian is sclected as the Fluid model for the Pipe Flow
interface and then Gas-Liquid, friction factor multiplier or Gas-Liquid, effective Reynolds

number are also chosen.

Use the Phase Fractions node to define the gas fraction as area averaged void fraction

or a quality mass fraction.

GAS FRACTION
Select a Gas fraction specification — Area averaged void fraction (volume fraction) or

Quality (mass fraction).

* For Area averaged void fraction (volume fraction) enter an Area averaged void fraction
@ (dimensionless). The default is 0.

 For Quality (mass fraction) enter a Quality @ (dimensionless). The default is 0.

Initinl Values

The Initial Values node adds initial values for the pressure and tangential velocity that
can serve as an initial condition for a transient simulation or as an initial guess for a

nonlinear solver.

INITIAL VALUES
Enter values or expressions for the initial value of the Pressure p (SI unit: Pa) and the

Tangential Velocity u (SI unit: m/s).

Inlet

Use the Inlet node to set the velocity, volumetric flow rate, or mass flow rate inlet
conditions that describe the fluid flow condition at an inlet.

In most cases the inlet boundary conditions appear, some of them slightly
modified, in the Outlet type as well. This means that there is nothing in
g the mathematical formulations to prevent a fluid from leaving the domain

through boundaries where the Inlet type is specified.
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CHAPTER 2:

INLET SPECIFICATION
Select a Specification for the inlet — Mass flow rate (the default), Velocity, Volumetric
flow rate. Additionally, Pump and Reservoir options are available for the Pipe Flow

interface.

* For Mass flow rate, enter a value or expression for the Mass flow rate g, o (SI unit:
kg/s). The default is 0 kg/s.

¢ For Velocity, enter a value or expression for the Velocity u( (SI unit: m/s). The
default is 0 m/s.

* For Volumetric flow rate, enter a value or expression for the Volumetric flow rate g, o
(ST unit: m3/s). The default is 0 mg/s.

» For Standard flow, SCCM, enter a value for standard cubic centimeters per minute.
The standard pressure and standard temperature as well as mean molar mass are
required as inputs as well. A standard cubic centimeter of gas is the amount of
molecules occupying a cubic centimeter at a specified standard temperature and
pressure, calculated by the ideal gas law. When used in the oil and gas industry, the
standard is often 15 degrees C and 100 kPa, but there are many other slightly
different standard conditions used in other circumstances. The inlet velocity

calculation is done according to

10 °poM
Y T 80T, ApR, ¥soCM

e For Pump, enter a value for the External pressure pqy (SI unit: Pa) and define the
relationship between the head and the volumetric flow rate— Pump curve data, or
User defined.

Pump Curve Data

When Pump curve data is selected as the Pump curve, a table appears, in which the
values of the Flow rate and the Head can be either specified or imported from a text file
by clicking the Load from file button ( = ) under the table. The interpolation between
points given in the table is defined using the Interpolation function type list in the Pump
Curve Interpolation section. Units can be specified for the Flow rate and the Head in the

Units section.

User Defined

With the User defined option, an expression for the Pump curve can be specified. The
flow rate across the point where this boundary condition is applied is defined by
phys_1d.VO where phys id is the name (by default for pipe flow, phys id is pfl).
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In order to avoid unexpected behavior, the function used for the pump curve returns

the maximum of the user-defined function and 0.

* For Reservoir, enter values for reservoir density and pressure. Select a Entrance type
— Projecting (K = 1) (the default), Sharp edged (K = 0.5), Rounded (K = 0.05), or User-

defined loss coefficient.

Outlet

Use the Outlet node to set the velocity, volumetric flow rate, or mass flow rate point

conditions that describe the fluid flow condition at an outlet.

I_El See Inlet for all settings.

All of the formulations for the Outlet type are also available, possibly
slightly modified, in other boundary types as well. This means that there
is nothing in the mathematical formulations to prevent a fluid from
entering the domain through boundaries where the Outlet boundary type

is specified.

No Flow

Use the No Flow node to define plugged exits or inlets (no flow).

Lossless Fitting

The Lossless Fitting node models junctions without losses. It is a default feature,
imposed at all junction points, that will be overridden by subsequent Bend, Valve,
Contraction/Expansion, Pump, T-junction, Y-junction, and n-way junction nodes

applied at overlapping points.

Pressure

Use the Pressure node to define the boundary pressure at points. The pressure
condition can only be applied to a point which is connected to exactly one edge (inlet

or outlet of a system).
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BOUNDARY PRESSURE
Enter a value or expression for the Pressure pg (SI unit: Pa). The defaultis 101325 Pa.

CONSTRAINT SETTINGS
To display this section, click the Show More Options button (“& ) and select Advanced
Physics Options.

Bend

Use the Bend node to introduce additional pressure losses due to irreversible turbulent

friction in a point associated with a bend in the pipe system.

The Bend can only be applied to a point which is connected to exactly two

= edges.

CHAPTER 2:

BEND SPECIFICATION
Select a Bend — 90 degrees standard elbow (K = 0.9) (the default), 45 degrees standard
elbow (K = 0.5), or User-defined loss coefficient. For User-defined loss coefficient enter a

Loss coefficient K (dimensionless).

CONSTRAINT SETTINGS
To display this section, click the Show More Options button (“& ) and select Advanced

Physics Options.
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Valve

Use the Valve node to introduce additional pressure losses due to irreversible turbulent
friction in a point associated with the position of a valve in the pipe system. Select a

predefined valve type or provide a user-defined loss coefficient.

— e —

The Valve can only be applied to a point which is connected to exactly two

= edges.

VALVE SPECIFICATION

Select a Valve — Globe valve (K = 10) (the default), Angle valve (K = 4.4), Gate valve (K
= 0.2), Ball valve (K = 4.5), Butterfly valve (K = 0.6), Swing check (K = 2.5), or
User-defined loss coefficient. For User-defined loss coefficient enter a Loss coefficient Kf

(dimensionless).

CONSTRAINT SETTINGS
To display this section, click the Show More Options button ("= ) and select Advanced
Physics Options.

Contraction/Expansion

Use the Contraction/Expansion node to introduce additional pressure losses due to
irreversible turbulent friction in a point associated with the position of a contraction or

expansion in the pipe system.

AT

T W

The Contraction/Expansion can only be applied to a point which is

= connected to exactly two pipe segments.
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CONTRACTION SPECIFICATION
Select an option from the Friction list — Sudden (the default), Gradual, or User-defined

loss coefficient.

¢ For Gradual, enter an Angle of convergence ¢ (SI unit: radians). The default is
0 radians.

* For User-defined loss coefficient, enter a Loss coefficient K (dimensionless). The
default is 0.

CONSTRAINT SETTINGS
To display this section, click the Show More Options button ("= ) and select Advanced
Physics Options.

Pumyp

Use the Pump node to introduce a pressure jump in a point associated with the position

of'a pump in the pipe system. Alternatively, specify a fixed mass flow rate for the pump.

_Q*

The Pump can only be applied to a point which is connected to exactly

= two edges.

CHAPTER 2:

PUMP SPECIFICATION

Select a Pump direction (available options are based on space dimension) — Pesitive X
direction (the default), Negative X direction, Positive Y direction, Negative Y direction,
Positive Z direction, or Negative Z direction. The pressure is increases in the direction

specified in the Pump direction.

Select an option from the Type list — Fixed flow rate (the default), Downstream

pressure, Pressure increase, and Pump curve.

* For Fixed flow rate, cnter a value or expression for the Mass flow rate m ., (SI unit:
kg/s). The default is 0 kg/s.

* For Downstream pressure, cnter a value or expression for the Pressure pgown (ST unit:
Pa). The default is 101 325 Pa.
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* For Pressure increase, enter a value or expression for the Pressure increase 4p (SI
unit: Pa). The default is O Pa.

¢ Pump curve specifies an relationship between the head and the volumetric flow rate

— Pump curve data, or User defined.

Pump Curve Data

When Pump curve data is selected as the Pump curve, a table appears, where values of
the Flow rate and the Head can be specified or imported from a text file by clicking the
Load from file button ( = ) under the table. The interpolation between points given in
the table is defined using the Interpolation function type list in the Pump Curve
Interpolation section. Units can be specified for the Flow rate and the Head in the Units

section.

User Defined

With the User defined option, an expression for the Pump curve can be specified. The
flow rate across the point where this boundary condition is applied is defined by
phys_1d.V0 where phys_id is the name (by default for pipe flow, phys id is pfl).
In order to avoid unexpected behavior, the function used for the pump curve returns

the maximum of the user-defined function and 0.

T-Junction

Use the T-Junction node to specify additional energy losses due to irreversible turbulent

friction in a T-junction, which can act as a split or a merger.
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SELECTION SETTINGS

pjunclian
v
Prnain Prnain
Pside

Figure 2-1: A T-junction with local pressuve indications.

The T-junction is intended for a point that is connected to exactly two
collinear main branches and one perpendicular side branch. If this

condition is not met, a warning message will be issued when solving. The

[

flow can go in either direction through each of the main branches and the

side branch. See Figure 2-1.

The automatic search for T-junction points is possible. If you want to use this option,
clear the Manual control of selections check box, the selections will be replaced by the
automatic ones. If you want to modity the selection, select Manual control of selections

again.

FRICTION SPECIFICATION

Several options to specify pressure drop across the junction branches are available.

* The Loss coefficients option allows you to enter a value or expression for the Loss
coefficient main branch K ;.. for the energy loss between main branch and junction
(the default is 0.1) and the Loss coefficient side branch K, for the energy loss
between the side branch and junction (the default is 1.2). Both are dimensionless
numbers. See Figure 2-1.

¢ The Loss coefficient with respect to common branch option is available for the Pipe
Flow interface. The loss coefficients are calculated automatically. The pressure loss
between the branches is expressed in terms of the flow variables in the common
branch. For joining flows, the common branch is the collector branch. For

separating flow, the common branch is the supplier branch.

¢ The Loss coefficients, extended model option is available for the Pipe Flow interface.
This option allows you to specity the loss coefficient in more details and account for
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the flow directions. Enter values or expressions for the six dimensionless loss
coefficients. See Figure 2-2-Figure 2-3.

4
Kmm
—_—

Kle | {K;:;rs

|/—'

j
Kem

Figure 2-2: T-junction, converging flow.

5
Kinm

5 5 5
Kims Kem Kem

Figure 2-3: T-junction, diverging flow..

* For details about pressure loss calculation, see T-junctions in Theory

E}‘ for the Pipe Flow Interface.

* Use the Pressure drops option to specify a value or expression for the pressure drop

explicitly for each branch respectively:
Apl, s pmain, 1~ Pside

ApQ, s =pmain, 2 7 Pside

Main 1 is the main pipe segment that has the lower index of the two in the selection

list (for example, see the list in Pipe Properties).

ADVANCED SETTINGS

The angle tolerance is used to specify the tolerance to a geometry not being a perfect
T. Increase the tolerance if you get an error message but accept the geometry even if

does not fulfill the requirements for an Y-shape.

CONSTRAINT SETTINGS

To display this section, click the Show More Options button ("= ) and select Advanced

Physics Options.
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Y-Junction

Use this feature to specify additional losses due to irreversible turbulent friction in a
Y-junction, which can act as a split or a merger. The pressure drop is calculated
according to

1 2
Ap = EKfpu ,

where Kpis a loss factor. Alternately, specify the pressure drop as a user-defined

expression.

Pside —x

pjunclian —

Figure 2-4: A Y-junction with local pressuve indications.

The Y-junction can only be applied to a point that is connected to exactly
two side branches and one main branch. The angle between each of the

side branches and main must be equal, and must not be 120 degrees. See

[

Figure 2-4. If these conditions are not met, use an n-way junction. The
flow can go in either direction through each of the main branches and the
side branch.

The automatic search for Y-junction points is possible. If you want to use this option,
clear the Manual control of selections check box, the selections will be replaced by the
automatic ones. If you want to modify the selection, select Manual control of selections

again.

FRICTION SPECIFICATION

The Loss coefficients options allows you to enter a value or expression for the Loss
coefficient main branch K, for the energy loss between side and junction and the Loss
coefficient side branch K .;,, for the energy loss between the main branch and junction
(the default is 1.2). Both are dimensionless numbers. See Figure 2-4. The respective

pressure losses are calculated as
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1 2
= EKf’ sidePside, lusidC, 1

1 2
‘psidc, 1t ﬁpsidc, 1%side, 1 ~ Pjunction

1 2
= QKf, sidePside, Zusidc, 2

1 2
‘pside, 2t ipside, 2Uside, 2 _pjunction

1

= QKf, mainpmainumain .

1 2

P main + épmainumain _pjunction

For Nonisothermal Pipe Flow and Reacting Pipe Flow interface interfaces, the
respective pressure drops are calculated as

- 2K 2
‘pside, 1 _pjunction‘ T 9 f, sidepuside, 1

_ 1 K 2
lpsidc, 2 _pjunction‘ - 5 f. sidcusidc, 2

- 1g 2
‘p main — P juncti0n| 9 f, mainP ¥ main
The advantage of using loss coefficients is that they are readily available in engineering

tables and textbooks.

Use the Pressure drops option to specify a value or expression for the pressure drop

explicitly for each branch respectively:
Apl, m = |pmain _psidc, 1|

Apz, m = Ipmain _psidc, 2|

Side 1 is the main pipe segment that has the lower index of the two in the selection list

(for example, see the list in Pipe Properties).

ADVANCED SETTINGS
The angle tolerance is used to specify the tolerance to a geometry not being a perfect
Y. Increase the tolerance if you get an error message but accept the geometry even if

does not fulfill the requirements for an Y-shape.

CONSTRAINT SETTINGS
To display this section, click the Show More Options button ("= ) and select Advanced
Physics Options.
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CHAPTER 2:

n-Way Junction

Use the n-Way Junction feature to specify additional pressure losses due to irreversible
turbulent friction in an n-way junction that does not fall into the categories Y- or
T-junctions. The number of pipe connections to a point can be any number, and the

angles between the connection pipes arbitrary.

Phranch —v’ Pbranch

P4 =

pjunclian

Figure 2-5: An n-Way Junction with local pressure indications.

FRICTION SPECIFICATION
The Loss coefficients options allows you to enter a value or expression for the Loss

coefficient main branch Ky ... .1, for the energy loss between branch and junction.

The pressure loss is calculated as

1 2 _1 K 2
pbranch, it Qpbranch, iubranch, i _pjunction - § branchpbranch, iubmnch’ i

For Nonisothermal Pipe Flow and Reacting Pipe Flow interfaces, the pressure drop is

calculated as
_1 K 2
|p branch, i _pjunction| - Q branchpubranch, i

Internal Pressure Lock

Use the Internal Pressure Lock node to specify the pressure at a point. The Internal
Pressure Lock condition can only be applied to a point which connects exactly two

edges.

Pipe Flow Physics Feature Symbols

For pipe flow interface, the physics symbols are available for internal points boundary
conditions. To display the boundary condition symbols listed in Table 2-1, enable the
Show physics symbols from the Graphics and Plot Windows menu on The Preferences
Dialog Box. The check box is not selected by default.
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These symbols are available with the applicable pipe flow feature nodes in the Pipe

Flow interface are reproduced in the table below:

TABLE 2-1: PIPE FLOW BOUNDARY CONDITION PHYSICS SYMBOLS
SYMBOL SYMBOL NAME DISPLAYED BY NODE
B
I Bend Bend
[+ Valve Valve
—
=] Pump Pump

Contraction/Expansion

T-Junction

Y-Junction

n-Way Junction

Contraction/Expansion

T-Junction

Y-Junction

n-Way Junction
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The Nonisothermal Pipe Flow

CHAPTER 2:

Interface

The Nonisothermal Pipe Flow (nipfl) interface (5. ), found under the Nonisothermal
Flow branch (=) when adding a physics interface, is used to compute the
temperature, velocity, and pressure fields in pipes and channels of different shapes. It
approximates the pipe flow profile by 1D assumptions in curve segments, or lines.
These lines can be drawn in 2D or 3D and represent simplifications of hollow tubes.

The physics interface is available in 3D on edges and 2D on boundaries.

When this physics interface is added, these default nodes are also added to the Model
Builder — Fluid, Pipe Properties, Pressure, Temperature, and Initial Values. Then, from
the Physics toolbar, add other nodes that implement, for example, boundary
conditions and volume forces. You can also right-click Nonisothermal Pipe Flow to select

physics features from the context menu.

SETTINGS

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers, and

underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is nipfl.

FLUID MODEL

Select a Fluid model — Newtonian (the default), Power law, or Bingham.

DEPENDENT VARIABLES

This physics interface defines these dependent variables (fields). If required, edit the
name, but dependent variables must be unique within a model:

* Pressure p (SI unit: Pa)

¢ Tangential velocity © (SI unit: m/s)

¢ Temperature 7" (ST unit: K)

FLUID FLOW INTERFACES



FURTHER READING

» For an explanation of the tangential velocity, see Theory for the Pipe

Flow Interface.

Gl. ¢ Edge, Boundary, Point, and Pair Nodes for the Nonisothermal Pipe

Flow Interface

e Theory for the Heat Transfer in Pipes Interface

Insulation of a Pipeline Section: Application Library path
I]I[l Pipe_Flow_Module/Heat_Transfer/pipeline_insulation

Edge, Boundary, Point, and Pair Nodes for the Nonisothermal Pipe
Flow Interface

Because The Nonisothermal Pipe Flow Interface is a multiphysics interface it shares
many nodes with other physics interfaces. These boundary, edge, point, and pair nodes
are available as indicated (and listed in alphabetical order).

Described in this section:

e Fluid

¢ Heat Transfer

These nodes are described for the Reacting Pipe Flow interface:

e Fluid Properties

e Pipe Properties

These nodes are described for the Heat Transfer in Pipes interface:
¢ External Film Resistance

e Internal Film Resistance

e Wall Heat Transfer
» Wall Layer

These nodes are described for the Heat Transfer interface in the COMSOL
Multiphysics Reference Manual:
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e Heat Source
¢ QOutflow

e Temperature

These nodes are described for the Pipe Flow interface (listed in alphabetical order):

* Bend e The Nonisothermal Pipe Flow

¢ Contraction/Expansion Interface

D .
o Inlet e Pressure

¢ No Flow * Pump

¢ n-Way Junction * T-Junction

¢ Outlet e Valve

L . .
e Phase Fractions Volume Force

e Y-Junction

In the COMSOL Multiphysics Reference Manual see Table 2-4 for links
to common sections and Table 2-5 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

CHAPTER 2:

Fluid

Use the Fluid node to define the density, dynamic viscosity, and heat convection and

conduction properties.

PRESSURE WORK

The Pressure Work section has an Include pressure work check box where a pressure
work term can be activated. When checked a contribution to the right-hand side of the
Heat Transfer in Pipes equation is added.

This term can be important to activate if the pressure drop is expected to be
considerable and the fluid is compressible. The pressure-volume work is added to the

energy balance.

For more information, see the section Theory for the Heat Transfer in Pipes Interface.
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FLUID PROPERTIES
The default Density p and Dynamic viscosity is specified here.

HEAT CONVECTION AND CONDUCTION
The default Heat capacity at constant pressure Cp (ST unit: J/(kg-K)), Ratio of specific
heats y (dimensionless), and Thermal conductivity % (SI unit: W/(m-K)) all use values

From material. For User defined enter different values or expressions.

Heat Transfer

Use the Heat Transfer node to define the density, yield stress, plastic viscosity, and heat

convection and conduction properties.

FLUID PROPERTIES
The default Density p (SI unit: kg/ms) is User defined and is 1.10° kg/m3.

Enter a value or expression for the Yield stress 7, (SI unit: Pa) and Plastic viscosity

(ST unit: Pa-s). The defaults are 0 Pa and 0 Pa-s, respectively.

HEAT CONVECTION AND CONDUCTION
The default Heat capacity at constant pressure Cp (ST unit: J/(kg-K)), Ratio of specific
heats y (dimensionless), and Thermal conductivity % (SI unit: W/(m-K)) all use values

From material. For User defined enter different values or expressions.
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The Water Hammer Interface

CHAPTER 2:

The Water Hammer (whtd) interface (i(0) ), found under the Fluid Flow>Single-Phase
Flow branch (=) when adding a physics interface, is used to compute the velocity and
pressure fields for propagation of a hydraulic transient, also known as a water hammer,
in elastic pipe systems. For example, the propagation of a water hammer in a piping

system of an oil refining plant.

The equations governing the propagation of hydraulic transients in pipes stem from
considering momentum, mass, and energy balances for a control volume of a piece of
pipe. In the formulation of the Water Hammer interface, the compressibility effects of
the fluid and pipe walls are linearized. The resulting equations are expressed in the
cross-sectional averaged variables and reduce the equations to a 1D component with
scalar field variables. The physics interface is available in 3D on edges and at points,

and in 2D on boundaries and points.

When this physics interface is added, these default nodes are also added to the Model
Builder — Fluid Properties, Pipe Properties, Closed, and Initial Values. Then, from the

Physics toolbar, add other nodes that implement, for example, boundary conditions.
You can also right-click Water Hammer to select physics features from the context

menu.

SETTINGS
The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers, and

underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is whtd.
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DEPENDENT VARIABLES

This physics interface defines these dependent variables (fields). If required, edit the
name, but dependent variables must be unique within a model:

* Pressure p (SI unit: Pa)

* Tangential velocity u (SI unit: m/s)

In the COMSOL Multiphysics Reference Manual see Table 2-4 for links
to common sections and Table 2-5 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

e Edge, Boundary, Point, and Pair Nodes for the Water Hammer
El Interface

e Theory for the Pipe Flow Interface

Water Hammer: Application Library path Pipe_Flow_Module/

I]I[l Verification_Examples/water_hammer_verification
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Edge, Boundary, Point, and Pair Nodes for the Water Hammer
Interface

The Water Hammer Interface has these edge, boundary, point, and pair nodes available

and listed in alphabetical order:

¢ Closed e DPipe Properties
* Fluid Properties e DPressure
¢ Local Friction Loss e Velocity

¢ The Initial Values and Volume Force nodes are described for the Pipe Flow

interface.

In the COMSOL Multiphysics Reference Manual see Table 2-4 for links
to common sections and Table 2-5 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

CHAPTER 2:

Fluid Properties

The Fluid Properties node adds the momentum equations solved by the physics
interface, except for volume forces which are added by the Volume Force node. The

node also provides an interface for defining the physical properties of the fluid.

PHYSICAL PROPERTIES
Select a Fluid model — Linear elastic (the default).

The default Density o (SI unit: l(g/ms) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity £ (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and the shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick

(such as oil) have a higher viscosity.

The default Speed of sound ¢, (SI unit: m/s) uses the value From material. For User

defined enter a different value or expression.
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Pipe Properties

The Pipe Properties node is used to define the pipe shape, pipe model, and flow

resistance.

PIPE SHAPE
The Pipe Shape settings are the same as for the Pipe Properties node described for the
Pipe Flow interface.

PIPE MODEL
Select a Pipe model — Zero axial stress (the default), Anchored at one end, Anchored at

both ends, or Incompressible cross section.
¢ For Zero axial stress, sclect a Young’s modulus E — Not set (the default) or User
defined. If User defined is sclected, enter a value or expression.

¢ For Anchored at one end or Anchored at both ends, enter a value or expression for the
Young’s modulus E. Select a Poisson’s ratio v — Not set (the default) or User defined.

For User defined enter a value or expression.

When Zero axial stress, Anchored at one end, or Anchored at both ends is sclected, also
select a Wall thickness Aw — Not set (the default) or User defined. For User defined enter

a value or expression.

FLOW RESISTANCE
The Flow Resistance settings are the same as for the Pipe Properties node described

for the Pipe Flow interface.

Local Friction Loss

Use the Local Friction Loss node to add a lumped friction loss that depends on the

velocity according to Equation 2-44.

FRICTION SPECIFICATION
Enter a Loss coefficient Ky (dimensionless). The default is 0.

CONSTRAINT SETTINGS
To display this section, click the Show More Options button ("= ) and select Advanced
Physics Options.
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Closed

Use the Clesed node to impose zero velocity.

Velocity

Use the Velocity node to prescribe a velocity.

VELOCITY

Enter a value or expression for u;, (SI unit: m/s). The defaultis 0 m/s.

Pressure

Use the Pressure node to define the boundary pressure at points.

PRESSURE

Enter a value or expression for the Pressure p (SI unit: Pa).

CONSTRAINT SETTINGS
To display this section, click the Show More Options button (“& ) and select Advanced
Physics Options.
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Theory for the Pipe Flow Interface

The Pipe Flow Interface and The Nonisothermal Pipe Flow Interface theory is

described in this section:

* Flow Equations

* References for the Pipe Flow Interface

Flow Equations

The Pipe Flow Interface calculates the pressure and velocity of an incompressible or
weakly compressible fluid by solving the continuity and momentum equations

outlined below.
A one dimensional pipe can be present on a boundary in a 2D geometry, or on an edge

in a 3D geometry.

MOMENTUM AND CONTINUITY EQUATIONS

The momentum and continuity equations for flow in a pipe are given by (Ref. 17):

du Vu = _Vp_ L )
5 TPu Vu = -Vp szdhu\u| +F 2-1)
and
%B +V.(Apu) =0 (2-2)

The second term on the right-hand side in Equation 2-1 represents the pressure drop
due to viscous shear. Here, u is the cross-section averaged velocity (SI unit: m/s), p

the density (SI unit: kg/ ms), p pressure (SI unit: Pa), fp (dimensionless) the Darcy

friction factor (see Expressions for the Darcy Friction Factor) and F is a volume force
term (SI unit: N/ms).

Furthermore, d}, is the mean hydraulic diameter (SI unit: m), given by:

d, = 4 (2-3)
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where A is the pipe cross section area (SI unit: m2) available for flow, and Z is the

wetted perimeter (SI unit: m).

Figure 2-6: Unit tangent vector to the pipe axis.

Let

€ = ( Cx Cry et,2)

be the unit tangent vector to the pipe axis.
If the following assumptions apply:

e The velocity profile is fully developed with an entire pipe section.

¢ The cross section area is allowed to change between pipe segments and within pipe

segments.

* Empirical functions (friction charts) describe viscous pressure drop both for

turbulent and laminar flow regimes

e The curvature of the pipe segment gives rise to insignificant pressure loss in
comparison with wall friction.

* Shocks are neglected

¢ All velocity components normal to the pipe axis is assumed to be 0,

the momentum balance in Equation 2-1 can be rewritten as

[oou Va=_Vp_f.2_ .
e, [pat+pu Vu=-Vp fD2dhu|u|+F} (2-4)

and we can define the tangential velocity u as u = ue.. The pipe tflow physics interface
in COMSOL Multiphysics solves for the tangential velocity ». This is also the quantity

the user specifies in for example inflow boundary conditions and in the initial

conditions settings.
Curvature pressure drop effects can be added in points with the Bend feature.

Gravity can be included explicitly in the model, but when the variation in density is
negligible, and the model is not pressure driven (the inlet boundary condition is a

pressure setting), the only effect of including gravity is a change in the total pressure
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level. In those cases, it is therefore common modeling practice to set the gravity F to
0 and interpret the pressure variable as the reduced pressure p = p — pg(zg — z), where
2z is the datum level of the free liquid surface. This reduces the model complexity and

yields the same results.

The Darcy friction factor in Equation 2-1 accounts for the continuous pressure drop
along a pipe segment due to viscous shear, and is expressed as a function of the
Reynolds number (Re) and the surface roughness divided by the hydraulic diameter
(e / dh) .

e
o =o(Re. ) (2-5)
where
d
e = 2% (2-6)
u

The physics interface automatically calculates f) from one of the predefined
expressions Equation 2-7 through Equation 2-13.

Expressions for the Darcy Friction Factor

Newtonian Fluids For single-phase fluids, the Churchill equation (Ref. 1) for the
Darcy friction factor can be used for the full range of Re (laminar, transition and
turbulent) and full range of e/d:

foe 8[(1%) 2 “ +13)71'5}1/12 o

where
A= [—2.457111((%)0'9+o.27(e/d))}16 2-8)
B - (37;’:0) o 2-9)

In the laminar regime (Re < 2000), fp is independent of the surface roughness and is

given by the Stokes formula:

f = 2= (2-10)
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The Wood equation (Ref. 2) gives the friction factor for 4000 < Re < 1107 and
1107 <e/d < 0.04, according to

0.225

f = 0.094(e/d)* > +0.53(e/d) + 88(e/d)’** - Re* (2-11)

with

0.134

a =-1.62(e/d) (2-12)

The Haaland equation (Ref. 3) for the Darcy friction factor is commonly used for oil
pipelines and wells. It can recover both small and large relative roughness limits for a
wide range of Reynolds numbers (4-103 <Re < 1-108)

JFI - —1.810gw((e;7 Y +(%)) (2-13)

D

It can be rewritten as
(1/1.8)
: e/ 1.11 6.9 2
(oe(57) " +(52)

For very low relative roughness e/d, the Haaland equation simplifies to Colebrook’s

T 6.9
A/;g = —1.810g10(Re) (2-15)

For very large relative roughness e/d, the Haaland equation simplifies to the von
Karman formula (Ref. 5)

JfT— = —1.810g10((63/f7d)1'“) = —210?510(%1) (2-16)

D

(2-14)

sz

explicit formula (Ref. 4)

An alternative to Haaland equation is the Swamee-Jain equation (Ref. 6)

0.25
(s (55) + )

The equation is valid for relative roughness 110 <e/d < 1.10°2 and for Reynolds
number in the range 5.103 < Re < 1.108.

(2-17)

sz
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All the above equations are selectable from a list of friction factor expressions. As
noted, only the Churchill equation covers both the laminar and turbulent flows, as well
as the transitional region in between these flow regimes. The equations by Wood,
Haaland, Colebrook, von Karman, or Swamee-Jain, intended for the turbulent regime,
are combined with the Stokes equation for laminar flow to cover all flow conditions.
When Re<1000, COMSOL Multiphysics selects Stokes equation if it predicts a friction
factor greater than equations for the turbulent regimes. This produces more accurate
results that using the turbulent frictions factors in the laminar regime, but it does not
necessarily produce accurate estimates of the friction factor in the transition region.
Therefore, it is always advisable to check the Reynolds number for a give pipe flow

solution and change the friction model and recalculate, if necessary.

The Newtonian fluid type also has two Gas-Liguid options, which employs a simple
two-phase approach presented by Balasubramaniam and others (Ref. 26). This is a
one-fluid approach that treats the fluid as one phase (one mass and momentum balance
is solved), but it corrects the pressure drop correlation with empirical factors for

liquid-gas mixtures. As such, the model also makes the following assumptions:

e The velocity of the gas and liquid phases are the same, meaning that no liquid
holdup is accounted for.

* No phase separation occurs due to gravity or other effects.

* No phase transition (condensation or vaporization) is assumed.

¢ The gas phase-fraction is assumed to be small so that the mixture is virtually

incompressible.

The first selectable method is the gas-liquid, friction factor multiplier, which
modifies the single-phase Newtonian Darcy friction factor defined in Equation 2-7 and

on, such that

fp = ®%2p - fp. 1L (2-18)

where fp 1, is the Newtonian single phase friction factor computed as described earlier

in this section. fpis then used as usual in the pressure drop correlation in Equation 2-4.
.. 2 .

The two-phase friction factor ®@“2p is calculated as (Ref. 26)

_ _ ~1/4
(DZQP = p—L[l + wG—(pL pG)Ml + mG(—uL “G)} (2-19)
P PG 2%e}
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where pr, Ur, PG, and pg are the density and viscosity of the liquid, and gas,
respectively, and where @ is the quality (the gas phase mass fraction). The total

density in Equation 2-19 is calculated as

P = 0GP+ (1-0g)py, (2-20)
or
1
= — (2-21)
P T og (-eg
PG PL

where ¢, is the user provided volumetric void fraction. The user has a choice to either
enter gas phase mass fraction g or volumetric void fraction ¢ . The conversion
formula between the two is

og = Lo (2-22)
PG

The second selectable gas-liquid method is the gas-liquid, effective Reynolds number.
This method uses an effective adjusted viscosity to calculate the Reynolds number in
the pressure loss calculations. The default mixture viscosity model is the extended
Einstein, which probably is the most accurate within a large range of gas mass fractions
(Ref. 27):

(ML +2.506)/ (ML + Mo
W=y (1-0g) (M +2.506)/ (ML + Ha) (2-23)

and the other options are

Linear average
o= up(1-9g) + g (2-24)

Reciprocal average

l (1_¢G)+g§
s M, 7e]

(2-25)

Liquid viscosity
W=y (2-26)

User defined.
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Non-Newtonian Power-law Fluids For Power-law fluids the apparent viscosity is
related to the shear rate as

-.n-1
Happ = M,(7)

where my, and n are two empirical curve fitting parameters known as the fluid
consistency coefficient and the flow behavior index, respectively. Note that the
dimensions of the consistency coefficient, m,, depend on value of the value of n. The
power law relation can be written as

-\n-1
Mypp = m[ylj (2-27)
ref/

Here m = mp(&ref)n - is the value of apparent viscosity at the reference share rate
Yref . The reference shear rate Yy has the default value 1 s'1. In the laminar regime
the friction factor for power law fluids can be calculated by the Stokes equation using
the modified Reynolds number proposed by Metzner and Reed (Ref. 7):

64

b= Reyg (2-28)
(2-n) 4n
u d
Repp = —— h (2-29)
8(n— 1)m (3n + 1)”
P\ 4n

For the turbulent regime Irvine (Ref. 8) proposed the following expression for the
friction factor:

fiy = 4(22) (2-30)

where

D(n) =

2" +4)( dn )3'12 (2-31)

77n 3n+1

Ryan and Johnson (Ref. 9) formulated a criterion for the transition between laminar
and turbulent flow, where
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1+
Reype = ———(2+n) (2-32)

predicts the critical Reynolds number.

Non-Newtonian Bingham Plastic Model. The Bingham model describes viscoplastic
fluid with a yield stress:

T=Tg+ “’BY for |T| > |TB| (2-33)

y=0 for |1| < |’CB|

The yield stress, Tg (SI unit: Pa), and the plastic viscosity, ug (SI unit: Pa-s), are found
by curve fitting to experimental data.

The Swamee-Aggarwal equation (Ref. 10) gives the friction factor for a Bingham
plastic fluid in the laminar regime according to:

1.143
10.67 + 0.1414[%—)
64 B He
fD laminar = Ra_ T 1.16 (_) (2-34)
Rep (1 + 0.149(3) ' )RcB Reg
Rey
where
ud
Rey = pu ) (2-35)
B
and
2
d;t
He = 2B (2-36)
Up
is the Hedstréom number.
For turbulent flow Darby (Ref. 11) provided the equation:
aopy, —0.193
fD,turbulcnt =4-10 RCB (2-37)

with
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ap = -1.47(1 + exp(-2.9 - 10 "He)) (2-38)

as well as an equation covering all flow regimes:

1

b
fD = (fll)), laminar T fllg, turbulent) (2-39)

where

40000

=1.
b 7+ Re,

(2-40)

Non-Newtonian Heschel-Bulkley Model. The Herschel-Bulkley non-newtonian model

is a generalization of Bingham plastic model

-\n-1
T=1p+ m[lj y for [1] > |t

Yret

(2-41)
y=0 for [t <|tp|

The yield stress, Tg (SI unit: Pa), and the consistency coefficient, m (SI unit: Pa-s), and

flow behavior index, n are found by curve fitting to experimental data.

The Swamee-Aggarwal equation (Ref. 12) gives the friction factor for a

Heschel-Bukley fluid in the laminar regime according to:

0.958n
64 64 1 He | 27"
e
fD,laminar = ReMR+ Reyp | 51246,05 Ry (2-42)
(ss+[22])
n
where Reyr is the modified Reynolds number given by Equation 2-29 and
2-n
2 —_—
d;/t n
He = p_.ﬁ(_é) (2-43)
mp Ny,
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is the Hedstrom number.

The non-Newtonian friction models outlined above do not include any

effects of wall roughness. Since the laminar sub-layers tend to be thicker

[

than non-Newtonian than for Newtonian fluids, the effect of pipe

roughness is likely to be smaller. Friction models including the surface

roughness can be used as user-defined specifications and can be found in

for example (Ref. 13).

CHAPTER 2:

The non-Newtonian friction models outlined above apply for pipes with circular

cross-section. The generalized Reynolds number needs to be modified to account for

other cross-sections.

Surface Roughness

Values of the absolute surface roughness found in the literature (Ref. 14 and Ref. 15)

are reproduced in the table below:

TABLE 2-2: SURFACE ROUGHNESS

TUBE MATERIAL

SURFACE ROUGHNESS (MM)

Smooth

Drawn tubing

Glass

Thermoplastics
Commercial steel and wrought iron
Steel, welded seamless
Asphalted cast iron
Galvanized iron
Cast-iron

Wood stave

Concrete

Riveted steel

Copper and brass

0
0.0015
0.0015
0.0015
0.046
0.061
0.12
0.15
0.26
0.18-0.9
0.3-3
0.9-9
0.61

Additional Flow Resistances

Additional flow resistance due to irreversible turbulent effects in joints and junctions

can be added as point conditions between pipe segments — Bends, Valves,
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T-junctions, Y-junctions, n-way junctions, Contractions, and Expansions. These

resistances give rise to abrupt (lumped) energy losses due to turbulence in the points

where they are added. The lumped pressure drop is calculated as:

Ap = %Kfpuz (2-44)

For more information about each type, see the interface descriptions in The Pipe Flow

Interface section.

Loss coefficients, K;, for turbulent flow are available in the literature (Ref. 15) and the

set predefined in the Pipe Flow interface is reproduced in the table below:

TABLE 2-3: LOSS COEFFICIENTS

FEATURE DESCRIPTION LOSS COEFFICIENT K
Bends 90° standard elbow 0.9
45° standard elbow 0.5
Valves Globe, fully open 10
Angle, fully open 44
Gate, fully open 0.2
Ball, fully open 4.5
Butterfly, fully open 0.6
Swing check, fully open 25
T-junction T-junction split/merger 0.1 and 2.1 for side and main. See

Contractions

Expansions

Sudden

Gradual, angle of
convergence o, < 22°

Gradual, angle of
convergence o. > 22°

Sudden

Gradual, angle of
convergence o < 22°

Gradual, angle of
convergence o, > 22°

Figure 2-1 for a description of flow
branches in a T-junction.

0.5(1-p%

0.8sin(o)(1-B)
0.5./sin(a)(1-B)
(1-p%
2.6sin(o)(1-B)>

(1-p)°
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Above, B is the ratio of small to large cross-sectional area. The point friction losses
listed above apply for Newtonian fluids. Point losses applying to non-Newtonian flow
can be added as user-defined expressions, for instance from (Ref. 16).

For the point pressure loss features Bends, Valves, T-junctions, Y-junctions, n-way
junctions, Contractions, and Expansions, the pressure loss can also be specified as a
pressure drop Ap directly.

T-junctions

Several options to specify pressure drop across the T-junction branches are available. If
the Loss coefficients option is selected, the energy loss between main branches and
junction and the he energy loss between the side branch and junction are calculated as

_1 2

= QKmainpmain, lumain, 1

2
‘pmain, 1t épmain, 1umain, 1 _pjunction

1

§K1na1n pmain, 2 umain) 2

2
pmain, 2t épmain, Zumain, 2 _pjunction

2
- 2Ksidc PsideUside -

1 2
‘psidc + § psidcuside _pjunction

Note, that for Nonisothermal Pipe Flow and Reacting Pipe Flow interface interfaces,

the respective pressure drops are calculated as

- 1g 2
|pmain, 1 _pjunction| -9 mainpumain, 1
1 2

\pmain, 2 _pjunction| = QKmainpumain, 2

1 2
= QKsidcpusidc .

|p side _pjunction‘
The Loss coefficient with respect to common branch option, that is available for the Pipe
Flow interface, implements the loss coefficients according to Ref. 28. The pressure loss
for T- junction is often expressed in terms of the flow in the common branch. For
joining flows, the common branch is the collector branch (Figure 2-2, left)

1 2 2 J 2
Pyt 2 pbub = Pcommon 2 P common¥common QK b, commonP ¢common¥ common

where K b, common 18 the loss coefficient between the branch b and the common
branch for joining flows.
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For separating flow, the common branch is the supplier branch

2 2 1 2
Py épbub = Pcommon T ipcommonucommon_éKsb’ commonP common¥ common

For converging (joining) flow, where the collector branch is the side branch
(Figure 2-2, left)

j 2
K'ms = 0.81-0.95q,, + 1.34q,,
For converging flow, where the collector branch is the main branch (Figure 2-2, right)

j 2
K'mm = 1-0.95q,,-0.16(qy. - g5, ) —0.46(1-g,,)

i 1.3 4 2 2
Ksm = —1+3.38q,,+((1-0.5dp: )dpe —1.84qbc )qp,

For diverging (separating) flow, where the supplier branch is the side branch
(Figure 2-3, left)

K'sm = 1-1.18q,, - 0.68q,,
For diverging flow, where the supplier branch is the main branch (Figure 2-3, right)

K'mm = 0.36-0.98g,,+0.62q., +0.03q,,

K'ms = 1-1.13q,,+(0.81 + (1.12d, - 1.08d5c +0.57)dpe )q.,

The mass flow rate ratio g, . = q3/q ommon and the hydraulic diameters ratio
dpe = dpp/ Ao nmon A€ computed automatically. Only junction with sharp corners
are considered.

The Loss coefficients, extended model option, that is available for the Pipe Flow

interface, allows you to specify the loss coefficient in more details and account for the
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flow directions. Enter values or expressions for the six dimensionless loss coefficients.

See Figure 2-2-Figure 2-3.

Figure 2-7: T-junction, converging flow.

Kfnm
—_—
' '
N ~
Kins Kim Km

Figure 2-8: T-junction, diverging flow.
The losses for the outgoing branches are calculated as
0 1 2 1 2
pav,in_pj,out_ipj,outu jout = Z EKi,in j,out Piin¥ iin
i, in
The total pressure is assume to be equal for all incoming branches:

0o _ 1 2
pav,in - pj,out + 2pj,0utu j,out

Use the Pressure drops option to specify a value or expression for the pressure drop
explicitly for each branch respectively:

Apl, s = pmain, 1~ Piside
Ap2) s = Pmain, 2 7 Pside

Main 1 is the main pipe segment that has the lower index of the two in the selection

list (for example, see the list in Pipe Properties).
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Theory for the Water Hammer
Interface

In this section:

* Flow Equations

e Reference for the Water Hammer Interface

Flow Equations

The Water Hammer interface implements both the continuity equation and the
momentum equations for a compressible fluid traveling inside pipes of variable cross

section.

THE CONTINUITY EQUATION

The mass conservation for a fluid inside a pipe is given by:

%Atﬁ +V-(Apu) = 0 (2-45)

where A (SI unit: m? ) is the cross section area of the pipe, p (SI unit: kg/’ m‘?’) is the
fluid density, and u (SI unit: m/s) is the tangential fluid velocity.

For adiabatic processes, the density and cross section area are function of the pressure,

so the continuity equation reads

BA(%)t L)y v. A@p@w) = 0 (2-46)
In a first order approximation, this equals

1,1\, y. _
AOpO(Kp+ KA) L 4V - (Agpgu) = 0 (2-47)

where K, is the bulk modulus of the fluid (the inverse of its compressibility), and K
is the effective bulk modulus of the cross section area. Ag and py are the reference area

and reference density at a given pressure py.

The Water Hammer wave speed ¢ (SI unit: m/s) is given by a combination of fluid and

structural material properties
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1_ (_1_ _.1_) -
== Po K, +KA (2-48)
The effective bulk modulus for the cross-sectional area K4 (SI unit: Pa) is given by the

pipe’s material properties

_ g
KA - Edh

where E is the Young’s modulus, dy, is the hydraulic diameter, and wyy, is the pipe’s
wall thickness. This is the so-called Korteweg formula (Ref. 1)

The Korteweg formula can also be extended to pipes suffering from axial stresses, in
this case, a more general formula would include the Poisson’s ration v of the pipe’s
material

EWn

K, ==
A th

(2-49)
where { = 1 for pipe with zero axial stress (this is Korteweg’s original formula for a pipe
furbished with expansion joints), { =1 — v/2 for a pipe anchored at one end, and

=1- v2 for a pipe anchored at both ends.

THE MOMENTUM EQUATION

The momentum equation is written as:

Ju p
p=; = -Vp-fi ulul+F (2-50)
ot D24,

here, fp is the Darcy friction factor, normally a function of the Reynolds number, the
surface roughness and the hydraulic diameter, as described in Expressions for the

Darcy Friction Factor.

This set of equations are normally acknowledged as the Water Hammer equations, and

are they mainly written in the literature as (consider gravity forces, so F = pg)

(é%_lz_pv -(Apu) =0 (2-51)
p%l;l = —Vp—fDé-%;ulul +pg (2-52)
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BOUNDARY CONDITIONS
The available boundary conditions are Closed, Pressure, Velocity, and Additional Flow
Resistances.

Reference for the Water Hammer Interface

1. M. Ghidaoui et al., “A Review of Water Hammer Theory and Practice”, Appl.
Mech. Rev. 58, pp. 49-76, 2005.

THEORY FOR THE WATER HAMMER INTERFACE ‘ 67



68 | CHAPTER 2: FLUID FLOW INTERFACES



Heat Transfer Interfaces

This physics interface, which is found under the Heat Transfer branch ( ||| ) when
adding a physics interface, has functionality for simulating heat transfer in pipe

networks, including wall heat transfer to the surroundings.
In this chapter:
* The Mechanisms for Heat Transfer

¢ The Heat Transfer in Pipes Interface

e Theory for the Heat Transfer in Pipes Interface

See The Heat Transter Interfaces in the COMSOL Multiphysics Reference

Manual for other Heat Transfer interface and feature node settings.
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The Mechanisms for Heat Transfer

The Heat Transfer in Pipes interface (B ), found under the Heat Transfer branch ( (/| )
when adding a physics interface, solves a temperature equation for a fluid transported
in a pipe. The physics interface requires the fluid velocity as input, provided either by
the user or by coupling to the Pipe Flow interface. However, it is advisable to instead
use The Nonisothermal Pipe Flow Interface which is a multiphysics interface that
combines Pipe Flow and Heat Transfer in Pipes to model the velocity, pressure and

temperature fully coupled.

The Heat Transfer in Solids, Heat Transfer in Fluids (general convection and
conduction, nonisothermal flow, and conjugate heat transfer), and Joule
Heating interfaces all belong to the COMSOL Multiphysics base package.
See The Heat Transfer Interfaces in the COMSOL Multiphysics

Reference Manual for more information.

[

CHAPTER 3:

COUPLING TO OTHER PHYSICS INTERFACES

It is often relevant to couple heat transport in pipe networks to heat transfer in the
region surrounding the pipe network. Simulating the cooling of a mold is a good
example of such an application. The Heat Transfer in Pipes interface or the
Nonisothermal Pipe Flow interface can be used to model the removal of heat in the
cooling channels represented by 1D edges, and couple that heat loss to a 3D model of
the mold. The pipe heat model is automatically coupled to the 3D surroundings.

More extensive descriptions of heat transfer, such as 3D turbulent flow models or
problems involving surface-to-surface radiation, can be found in the Heat Transfer
Module. Furthermore, some cases that involve geothermal applications with
groundflow models for porous media are better handled by the Subsurface Flow
Module.
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The Heat Transfer in Pipes Interface

The Heat Transfer in Pipes (htp) interface (g ), found under the Heat Transfer
branch ( ||( ) when adding a physics interface, is used to model heat transfer by
conduction and convection in pipes and channels of diftferent shapes, where the fluid
velocity and pressure fields are known a priori. It provides 1D models to define the pipe
flow profile and temperature profiles on curve segments, or lines. These lines can be
drawn in 2D or 3D and represent simplifications of hollow tubes. Wall heat transfer,

including multilayer walls and cladding is included as an option.

The temperature equation corresponds to a 1D convection-diffusion equation that

may contain additional contributions like heat sources.

The Nonisothermal Pipe Flow Interface extends this physics interface by providing

equations to compute the velocity and pressure fields when they are unknown.

When this physics interface is added, these default nodes are also added to the Model
Builder — Heat Transfer, Pipe Properties, Temperature, and Initial Values. Then, from the
Physics toolbar, add other nodes that implement, for example, boundary conditions.
You can also right-click Heat Transfer in Pipes to select physics features from the context

menu.

SETTINGS
The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers, and

underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is htp.

DEPENDENT VARIABLES
This physics interface defines the Temperature T (SI unit: K) dependent variable (field).

If required, edit the name, but dependent variables must be unique within a model.
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DISCRETIZATION

The default discretization for temperature is quadratic.

* Edge, Boundary, Point, and Pair Nodes for the Heat Transfer in Pipes
Interface
@l * Theory for the Heat Transfer in Pipes Interface
* Handling Frames in Heat Transtfer in the COMSOL Multiphysics

Reference Manunl

Edge, Boundary, Point, and Pair Nodes for the Heat Transfer in Pipes
Interface

The Heat Transfer in Pipes Interface has these boundary, edge, point, and pair nodes
available from the Physics ribbon toolbar (Windows users), Physics context menu (Mac

or Linux users), or right-click to access the context menu (all users).

In general, to add a node, go to the Physics toolbar, no matter what
'g' operating system you are using. Subnodes are available by clicking the
parent node and selecting it from the Attributes menu.

¢ Heat Outflow e Pipe Properties
¢ Heat Source e Temperature
e Heat Transfer e Wall Heat Transfer

e Initial Values

In the COMSOL Mulitiphysics Reference Manual see Table 2-4 for links
to common sections and Table 2-5 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

Heat Transfer

Use the Heat Transfer node to define the tangential velocity, density, dynamic viscosity,

and heat convection and conduction properties.
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FLUID PROPERTIES
The default Density p (ST unit: kg/ms) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity # (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and the shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick

(such as oil) have a higher viscosity.

HEAT CONVECTION AND CONDUCTION

Select an option from the Tangential velocity list — User defined, Tangential velocity
(nipfl/nipfl), or Tangential velocity (pfl/pfl). For User defined enter a value for the
Tangential velocity z (SI unit: m/s).

The default Density p (SI unit: kg/ms), Dynamic viscosity £ (SI unit: Pa-s), Heat capacity
at constant pressure C}, (SI unit: ] /(kg-K)), Ratio of specific heats y (dimensionless),
and Thermal conductivity £ (SI unit: W/(m-K)) all use values From material. For User

defined enter different values or expressions.

Heat Source

The Heat Source describes heat generation within the domain. Express heating and
cooling with positive and negative values, respectively. Add one or more nodes as
needed — all heat sources within a domain contribute to the total heat source.

HEAT SOURCE
Click the General source, Linear source or Heat rate button.
¢ For General source enter a value for the distributed heat source @ (SI unit: W/ m3).

* For Heat rate enter a value for the heat rate Py(SI unit: W). In this case @=P/L

where L is the total length of the selected boundaries.

* For Linear source (Q = g4 T) enter the Linear heat source g4 (SI unit: W/(mSK))

The advantage of writing the source in this form is that it can be stabilized
by the streamline diffusion. The theory covers g4 that is independent of
g the temperature, but some stability can be gained as long as g is only

weakly dependent on the temperature.

THE HEAT TRANSFER IN PIPES INTERFACE
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Numerical Stabilization in the COMSOL Multiphysics Reference
ﬁl Manual

Wall Heat Transfer

Use the Wall Heat Transfer node to set up heat exchange across the pipe wall. Define
the external temperature and the nature of the heat transfer. The Internal Film
Resistance, Wall Layer, and External Film Resistance subnodes are available from the
context menu (right-click the parent node) or from the Physics toolbar, Attributes
menu. These compute heat transfer coefficients based on the section Theory for the

Heat Transfer in Pipes Interface.

You must add at least an Internal Film Resistance subnode. This
corresponds to a drilled channel in a solid. If a pipe wall exists, (pipe

embedded in a solid), add also Wall Layer. If the pipe wall has more than

[

one layer, add more Wall Layer features. If the pipe exchanges heat to a

surrounding fluid by forced or natural convection, add also External Film

CHAPTER 3:

Resistance.
Internal film External film
4 [ Wall Heat Transfer 1
(= Internal Film Resistance 1 /

(= Steel pipe wall
[EY Insulation layer
(= External Filrm Resistance 1

%

Wall layers

Figure 3-1: Internal and external films and the associated film coefficients (blue), and
wall layers (davk and light gray).

HEAT TRANSFER MODEL

Select an option from the External temperature list — User defined, or Temperature
(ht/ht), the latter representing a temperature field calculated by a surrounding 3D solid
physics. For User defined enter a value for the External Temperature T, (SI unit: K). If
an expression is used for T,; that is a locally defined variable on the edge, the check

box Take average in adjacent domain should be cleared.
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Internal Film Resistance

The Internal Film Resistance subnode is available from the context menu (right-click the
Wall Heat Transfer parent node) or from the Physics toolbar, Attributes menu. Use it

to define the film resistance.

Even if you do not expect a boundary layer to build up, the thermal film
. theory works well for laminar flow profiles. In fact, there is an analytical
|_i| solution available to the Nusselt number for laminar flow in circular tubes

(Nu = 3.66).

FILM RESISTANCE

The default Internal film resistance model is Automatic and the Nusselt number is
computed as described in the section Theory for the Heat Transfer in Pipes Interface.
For User defined enter a value for the Nusselt number (dimensionless). The default is
3.66.

External Film Resistance

The External Film Resistance subnode is available from the context menu (right-click
the Wall Heat Transfer parent node) or from the Physics toolbar, Attributes menu. Use
it to define the external film resistance features including the material, thermal
conductivity, density, external velocity, and pressure of the external fluid. You can select

between forced and natural convection.

SPECIFICATION
Select an External film heat transfer model — External forced convection (the default),

External natural convection, or User defined.

External Forced Convection and External Natural Convection
For External forced convection or External natural convection the Surrounding fluid uses

the Domain material by default.

Be careful to select the right material in the Settings window for External
.& Film Resistance. Many times this should be another material than the

Domain material which is the internal fluid.

THE HEAT TRANSFER IN PIPES INTERFACE
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The default Heat capacity at constant pressure Cp (ST unit: J/(kg-K)), Thermal
conductivity % (ST unit: W/(m-K)), Density p (SI unit: kg/ms), and Dynamic viscosity
4 (ST unit: Pa-s), all use values From material. For User defined enter different values or

expressions than the default, which is 0 for all options.

The External velocity u,,; (SI unit: m/s) is User defined by default. This is the velocity
of the cooling or heating fluid outside the pipe.

For External natural convection only, also enter a value or expression for the External

pressure p,,; (SI unit: Pa). The default is 1 atm.

The natural convection correlations (see External Film Resistance under
The Heat Transfer Equation in the section Theory for the Heat Transfer
in Pipes Interface) require a temperature dependent density, or else the

coeflicient of thermal expansion B evaluates to 0 (Equation 3-26), which

[

might generate unexpected results or even unstable models. Also, make
sure that the density correlation p(7T') is smooth throughout the
temperature interval used, or else B is discontinuous and can cause

numerical instability.

rho(1.01e5,T)

4 558 Materials
4 528 Crude oil (matl)
2= Basic (def)
A 553 Air (matZ)
4 528 Basic (def)
. Piecewise (eta)
M Piecewise 2 (Co)
8 Analytic (rho)

Figure 3-2: Before you use the Natural Convection option, it is good practice to select
Density in the used material, and click Plot in the Settings window. That way you can
inspect the behavior and make sure it is smooth within the temperature interval you plan
to use it.

User Defined
For User defined:

* Enter the Nusselt number (dimensionless). The default is 3.66.

¢ The Surrounding fluid uses the Domain material by default.
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¢ The Thermal conductivity 2 (ST unit: W/(m-K)) takes its value From material. For
User defined enter a different value or expression. The default is 0 W/(m-K).

¢ Enter a value or expression for the External pressure p,,; (SI unit: Pa). The default
is 1 atm).

Wall Layer

The Wall Layer subnode is available from the context menu (right-click the Wall Heat
Transfer parent node) or from the Physics toolbar, Attributes menu. Use it to define the

thermal conductivity and wall thickness. You can add more layers.

SPECIFICATION

Select an option from the Thermal conductivity list £ (SI unit: W /(m-K)) — Not set (the

default) or User defined to enter a different value or expression. The default is
0 W/(m-K).

Select an option from the Wall thickness list Aw (SI unit: m) — Not set (the default) or

User defined. For User defined enter a value or expression. The default is 0 m.

You must add at least an Internal Film Resistance subnode. This
corresponds to a drilled channel in a solid. If a pipe wall exists, (pipe
embedded in a solid), add also Wall Layer. If the pipe wall has more than

i

one layer, add more Wall Layer features.

Internal film External film
4 [ Wall Heat Transfer 1
[ Internal Film Resistance 1 /
[ Steel pipe wall ‘

* .
=7 Insulation layer
[ External Filrm Resistance 1

e

Wall layers

Figure 3-3: Internal and external films and the associated film coefficients (blue), and
wall layers (dark and light gray).
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Wall Heat Transfer, Inner

Use the Wall Heat Transfer, Inner node to set up heat exchange across the pipe wall.
This feature is only applicable if Concentric circular annular is selected as Pipe Shape in
the Pipe Properties node. Define the core temperature T, and the nature of the heat
transfer. The Internal Film Resistance and Wall Layer subnodes are available from the
context menu (right-click the parent node) or from the Physics toolbar, Attributes
menu. These compute heat transfer coefficients based on the section Theory for the
Heat Transfer in Pipes Interface.

You must add at least an Internal Film Resistance subnode. This

corresponds to a drilled channel in a solid. If a pipe wall exists, (pipe

[

embedded in a solid), add also Wall Layer. If the pipe wall has more than
one layer, add more Wall Layer features.

CHAPTER 3:

b Y5 wall Heat Transfer 1 Internal film Core
4 [ wall Heat Transfer, Inner 1

[ Internal Film Resistance 1

B wall Laver 1

Wall layers

Figure 3-4: Internal film (blue) and wall loyer (light gray).

Initial Values

The Initial Values node adds an initial value for the temperature that can serve as an

initial condition for a transient simulation or as an initial guess for a nonlinear solver.

INITIAL VALUES

Enter values or expressions for the initial value of the Temperature 7" (SI unit: K).

Temperature

Use the Temperature node to specify the temperature at an inlet of the pipe system.
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TEMPERATURE
The equation for this condition is T' = Ty, where T, is the prescribed temperature

(SI unit: K) on the boundary. Enter the value or expression for the Temperature T',.
The default is 293.15 K.

CONSTRAINT SETTINGS
To display this section, click the Show More Options button ("= ) and select Advanced
Physics Options in the Show More Options dialog box.

Heat Outflow

The Heat Outflow node provides a suitable boundary condition for
convection-dominated heat transfer at outlet boundaries. In a model with convective
heat transfer, this condition states that the only heat transfer over a boundary is by
convection. The temperature gradient in the normal direction is zero, and there is no
radiation. This is usually a good approximation of the conditions at an outlet boundary
in a heat transfer model with fluid flow.
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Theory for the Heat Transfer in Pipes

CHAPTER 3:

Interface

The Heat Transfer in Pipes Interface and The Reacting Pipe Flow Interface theory is
described in this section:

e The Heat Transfer Equation

¢ Reference for the Heat Transfer in Pipes Interface

The Heat Transfer Equation

This physics interface solves an energy balance equation for 1D pipes, taking the flow

velocity as input.

HEAT BALANCE EQUATION

The energy equation for an incompressible fluid flowing in a pipe is (Ref. 25):

oac T

VT = V. PA B }
D¢ +pACpu VT =V AkVT+fD2dh|u| +Q+Qwall+Qp (3-1)

where p is the fluid density (SI unit: kg/ m‘?’), A is the pipe cross section area

(ST unit: m? ) available for flow, C, (SI unit: ] /(kg-K)) is the heat capacity at constant
pressure, T' (SI unit: K) is the temperature. u is a velocity field. For information about
the tangential velocity in pipe flow, see Theory for the Pipe Flow Interface. Further, £
(ST unit: W/(m-K)) is the thermal conductivity. The second term on the right hand
side corresponds to friction heat dissipated due to viscous shear. @ (SI unit: W/m)
represents a general heat source and Q41 (SI unit: W/m) represents external heat

exchange through the pipe wall. Note that the @y, term is detailed below.

An additional term @, can be added to the right-hand side of the equation by enabling
the Pressure Work check box:

This term is optional and can be used if the pressure drop is expected to be
considerable and the fluid is compressible. The contribution follows the same theory
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as the pressure work term described in the section The Nonisothermal Flow and
Conjugate Heat Transfer Equations in the Heat Transfer Module User’s Guide.

Wall Heat Transfer
The radial heat transfer from the surroundings into the pipe is given by

Qua = (h2) (T —T) (W/m) (3-3)

In Equation 3-3, (hZ)g is an effective value of the heat transfer coefficient i
(SI unit: W/(mz-K)) times the wall perimeter Z (SI unit: m) of the pipe. Tyt
(SI unit: K) the external temperature outside of the pipe. See Figure 3-5. Qa1 appears

as a source term in the pipe heat transfer equation, Equation 3-1.

The Wall Heat Transfer feature requires the external temperature and at least an
internal film resistance subnode added to it. The individual contributions of heat
transfer coefficients can be added by subnodes to the Wall Heat Transfer feature. The

subnodes are:
¢ Internal Film Resistance

* Wall Layer

¢ External Film Resistance

T

[
temperature field computed by another physics interface, typically a 3D Heat Transfer

«t in Equation 3-3 can be a constant, parameter, expression, or given by a

interface. A is automatically calculated through film resistances and wall layers that are

added as subnodes; see Equation 3-17 an on.

If Tyt is given as the temperature field computed by another 3D Heat Transfer
interface, automatic heat transfer coupling is done to the 3D physics side as a line
source. The temperature coupling between the pipe and the surrounding domain is
implemented as a line heat source in the 3D domain. The source strength is
proportional to the temperature difference (Equation 3-3) between the pipe fluid and

the surrounding domain.

THEORY FOR THE HEAT TRANSFER IN PIPES INTERFACE
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The overall heat transfer coefficient including internal film resistance, wall resistance

and external film resistance can be deduced as follows, with reference to Figure 3-5.

Layered pipe wall

Fluid domain

dr ro Aw,
A
T| T, T,
Ty
T,
Tx
Wall number: 1 2n N Text
| -

ro r
Figure 3-5: Temperature distribution across the pipe wall.

* 7, (ST unit: m) is the outer radius of wall n

e w=r—-rg (ST unit: m) a wall coordinate, starting at the inner radius r
e Aw,=r,—ry_1 (ST unit: m) the wall thickness of wall n

e Z, (ST unit: m) is the outer perimeter of wall n

¢ Byt and Agy are the film heat transfer coefficients on the inside and outside of the
tube, respectively (SI unit: W/ (m2 -K)).

¢ ks the thermal conductivity (SI unit: W/(m-K)) of wall n

Shell balance In Figure 3-5, consider a short length section AL of pipe, perpendicular

to the figure plane. The heat leaving the internal fluid of that segment into the wall is

Qo = hiyAg - (T-Tg) (W) (3-4)

Here, Ag = AL2mr( (SI unit: m2) is the area available for heat flux into the wall. For
stationary conditions that same amount of heat must travel through any cylindrical

shell at radius 7 in wall 1 (or any wall).
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Q, = aL2wr (4, 2L (3-5)

Rearrange and integrate from rg to ry.

T, ro
@ 1
Jar = (a3 56
T, To
Perform the integration
Q 1
TI_TO = —m‘; . ln(;‘-(—) (3-7)
and rearrange
_ AL2mk, 7
1= (Ty-T7). (3-8)

For the example of two wall layers, the heat flow is equal across any shell from the inner

bulk fluid to the surroundings, and we can setall @ | = @ .

Q = h, AL2mr, - (T-T)
AL2rk,
In(ry/rq)
AL2rk,
In(ry/7q)
Q =h AL2nry- (Ty-T

(Ty-T1)
(3-9)
(T-Ty)
ext)
Substituting
O = AL2n, (3-10)
and making a linear combination of the equations Equation 3-9 gives

Q= (hAQ)cff. (T- Text) (3-11)

where (hAg)efr is an effective conductance:

THEORY FOR THE HEAT TRANSFER IN PIPES INTERFACE ‘
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1
In(r,/ 1 /
. (rq ’”0)+ n(ry ’"1)+ 1
roh. © k0 ky©O roh O

mnt ext

(hAQ) 4 = (3-12)

For the general case with N wall layers this reads

1

off T r
In (—-—-9-)
1 Ty 1

N
n-1
+ +
rohintG) Zl kll@ rNhext®
n=

(hAg) (3-13)

Now let

(hAp)
(hZ) 5 = —A?; f (3-14)

where Z (SI unit: m) is an average perimeter (circumference), of the pipe, taken over

the thickness of the pipe walls. Combine Equation 3-10 and Equation 3-14 such a that
(hAQ) g = (hZ) 40/ (2m)

and insert in Equation 3-13:

(hZ) s = 21 (3-15)

e

1 Th-1
roh Tk +Zl k,

nt ext

For a circular pipe cross sections, this effective AZ in can now be used in Equation 3-3.
Note the reversed sign since @411 is the heat added to the pipe from the surroundings.
The assumption in the deduction above is

¢ equal temperature around the circumference of the

¢ the heat transfer through the wall is quasi static. The latter means that the wall is
assumed to immediately assume the equilibrium temperature distribution
corresponding to T and Teyy. If this assumption would not be made, an auxiliary

PDE across the wall coordinate would be required.

For square and rectangular pipe shapes the average conductance can be approximated
by the simpler sum of resistances across a plane wall, which can be found in for example
(Ref. 14):
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(hZ) e = N (3-16)
1 1 w,
+ +
Zohint ZNhext Zkll((Z11+Z11.1)/2)
The film resistances can be calculated from
h = Nuk (3-17)
= Z

where & is the thermal conductivity of the material, and Nu is the Nusselt number. dj,
is the hydraulic diameter, defined as

dy = 4A/Z. (3-18)

e The inner and outer film coefficients is evaluated at (T + T)/2 and (TN + Text)/2,
respectively.

¢ The thermal conductivity &, can be temperature dependent and is evaluated at
Ty+ Ty 1)/2.

e To compute d}, in Equation 3-18 the local perimeter is calculated as Z = flw) and
the cross section area as A = f{w). Automatic calculations for circular tubes are done
by the physics interface as Z = 2nr and A = nr2. For rectangular tubes it is
Z = 2(width + height) and A = width - height. For user-defined pipe shapes, the user

can enter arbitrary expressions.

The local temperatures in each radial position of the pipe wall (see Figure 3-5) are
computed considering the fact that Equation 3-3 also can be applied for each
individual wall layer:

Quu = (RD) T 1 -T,) (8-19)

wall —

Combining Equation 3-3, Equation 3-19 and Equation 3-15 or Equation 3-16
(depending on pipe shape) for each wall layer explicitly gives each T,.

Internal Film Resistance For internal laminar forced convection in fully developed
pipe flow, the Nusselt number is a constant that depends on the pipe cross-section.
Values are listed in the table below (Ref. 1). The Pipe Flow interface interpolates to
find values for width /height ratios not listed. Default settings for film coefficient

THEORY FOR THE HEAT TRANSFER IN PIPES INTERFACE
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calculations are “Automatic”, which means that laminar and turbulent correlations are

applied according to the Re number.

TABLE 3-1: NUSSELT NUMBERS FOR INTERNAL LAMINAR PIPE FLOW

CROSS SECTION WIDTH/HEIGHT NU

circular - 3.66
square | 2.98
rectangular 1.43 3.08
rectangular 2 3.39
rectangular 3 3.96
rectangular 4 4.44
rectangular 8 5.60
parallel plates infinity 7.54

For user-defined cross sections, Nu is suggested to 3.66 as a default.
For internal turbulent forced convection (3000 < Re < 6-106, 0.5 < Pr < 2000), the

Gnielinski equation (Ref. 19) applies:

/8)(Re - 1000)P
Nu. = — Ip/8)(Re )Pr (3-20)

int l+12.7(fD/8)1/2(Pr2/3—1)
Where Pr is the Prandtl number:
C
Pr = _]{;ﬂ (3-21)

The film resistance due in the internal flow can be calculated using material properties
defined in the Heat Transfer feature and the calculated friction factor. Material
properties are evaluated at the mean internal film temperature (T + T)/2 (see

Expressions for the Darcy Friction Factor).

The using the hydraulic diameter makes the equations applicable to non-circular pipe

cross sections.

External Film Resistance The material properties used should be those of the external
fluid. Do not set the material to Domain Material if you have a different fluid on the
inside and outside. Typically, the temperature and pressure are required to evaluate the
material functions. The external fluid velocity is required for the Forced Convection

option and is a user-defined input.
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For External forced convection around a pipe, valid for all Re and for Pr > 0.2, the

Churchill and Bernstein (Ref. 20) correlation is used:

0.62Re!2pr!3

1/4
[1+(0.4/Pr)%?3]

[1+(Re/ 2820000 %"° . (3-22)

Nu,, = 0.3+

For External natural convection around a pipe, the Churchill and Chu (Ref. 21)

correlation is used which is recommend for Ra < 1012

1/6 2
Nu,, = {0.60 ¥ 0.387Ra } (3-23)
? 9/16,8/27
[1+(0.559/Pr)”" ]
where the Rayleigh number is given by:
Ra = PrGr (3-24)
and the Grashof number is:
gB| Ty~ Tod’
Gr = ——-————-—————55‘-‘-—-—- (3-25)
®)
p
Above d is the outside diameter of the pipe and, B is the fluid’s coefficient of
volumetric thermal expansion:
_ 1 QE) ]
B = p(BT (3-26)

p

Material properties are evaluated at (T'\ + Text)/2.

STABILIZATION OF THE HEAT TRANSFER EQUATION

The transport equation in the Heat Transfer in Pipes interface is numerically stabilized.

Numerical Stabilization in the COMSOL Multiphysics Reference
.& Manual

Reference for the Heat Transfer in Pipes Interface

1. E.P. Incropera and D.P. DeWitt, Fundamentals of Heat and Mass Transfer, 4th
ed., John Wiley & Sons, 1996.

THEORY FOR THE HEAT TRANSFER IN PIPES INTERFACE
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Chemical Species Transport Interfaces

This chapter has information about the physics interfaces found under the

Chemical Species Transport branch ( #:2).
In this chapter:
¢ The Transport of Diluted Species in Pipes Interface

¢ The Reacting Pipe Flow Interface
e Theory for the Transport of Diluted Species in Pipes Interface
See The Transport of Diluted Species Interface in the COMSOL Multiphysics

Reference Manual for other Chemical Species Transport interface and feature

node settings.
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The Transport of Diluted Species in
Pipes Interface

The Transport of Diluted Species in pipes (dsp) interface ( =!), found under the Chemical

Species Transport branch ( 22 ) when adding a physics interface, is used to model a mass
balance equation for pipes in order to compute the concentration distribution of a
solute in a dilute solution, taking into account diftfusion, dispersion, convection, and
chemical reactions. The physics interface approximates the concentration profile in
pipes and channels by a 1D assumption on lines in 2D and 3D. Depending on

additional add-on products, multiple species can be modeled.

When this physics interface is added, these default nodes are also added to the Model
Builder — Convection and Diffusion, Concentration, and Initial Values. Then, from the
Physics toolbar, add other nodes that implement, for example, boundary conditions
and volume forces. You can also right-click Transport of Diluted Species in Pipes to sclect

physics features from the context menu.

The Reacting Pipe Flow Interface node uses this physics interface and couples it

automatically to Pipe Flow and Heat Transfer in pipes.

SETTINGS

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to

different physics interfaces, the name string must be unique. Only letters, numbers, and
underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is dsp.

FLUID MODEL

Select a Fluid model — Newtonian (the default), Power law, Bingham, or Herschel-Bulkley.

DEPENDENT VARIABLES
This physics interface defines these dependent variables (fields) — Number of

concentrations ¢ (SI unit: mol/ms) and Concentrations.
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If required, edit the name, but dependent variables must be unique within a model:

To enable multiple species (more than one concentration), you need a
license for one of these modules: Battery Design Module, CFD Module,
Chemical Reaction Engineering Module, Corrosion Module,
Electrodeposition Module, Fuel Cell & Electrolyzer Module,
Microfluidics Module, or Subsurface Flow Module.

e

Edge, Boundary, Point, and Pair Nodes for the Transport of Diluted
Species in Pipes Interface

* Edge, Boundary, Point, and Pair Nodes for the Transport of Diluted
El Species in Pipes Interface

¢ Theory for the Transport of Diluted Species in Pipes Interface

The Transport of Diluted Species in Pipes Interface has these boundary, edge, point,
and pair nodes available from the Physics ribbon toolbar (Windows users), Physics
context menu (Mac or Linux users), or right-click to access the context menu (all

users).:

In general, to add a node, go to the Physics toolbar, no matter what
'g' operating system you are using. Subnodes are available by clicking the

parent node and selecting it from the Attributes menu.

* Concentration * Pipe Properties
¢ Convection and Diffusion e Reactions
e Initial Values e Wall Mass Transfer

e Mass Outflow

In the COMSOL Multiphysics Reference Manual see Table 2-4 for links
to common sections and Table 2-5 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.
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Convection and Diffusion

Use the Convection and Diffusion node to define the fluid properties, velocity, diffusion
coefficient, and dispersion model. This node as present by default.

FLUID PROPERTIES
The default Density o (SI unit: kg/mg) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity £ (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and the shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick,

such as oil, have a higher viscosity.

VELOCITY

Enter a value or expression for the Tangential velocity u (SI unit: m? /s). The default
: 2
is 0 m“/s.

DIFFUSION COEFFICIENT

Enter a value or expression for the diffusion coefficient D,, (SI unit: m? /s). The default
is1x107 mz/s.

DISPERSION

Select a Dispersion model — User defined (the default), Taylor (laminar, circular cross
section), or Taylor (turbulent, circular cross section). For User defined, enter a value or
expression for the Dispersion coefficient Dpy (SI unit: mz/s). The default is 0 m2/s.
Find more detail in the theory section Dispersion.

Initial Values

The Initial Values node adds an initial value for the concentration that can serve as an

initial condition for a transient simulation or as an initial guess for a nonlinear solver.

INITIAL VALUES

Enter values or expressions for the initial value of the Concentration ¢
(SI unit: mol/ms). The default is 0 mol/ms.
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Reactions

Use the Reactions node to account for the consumption or production of species.
Define the reaction rate expression as needed, which displays on the right-hand side of

the species transport equations in the Convection and Diffusion node.

REACTIONS
Enter a Reaction rate R, (SI unit: mol/(m3~s)). The default is 0 mol/(m3~s).

Wall Mass Transfer

Use the Wall Mass Transfer node to model species loss to the surroundings of the pipe.
This could be used if the diluted species is soluble in the pipe wall or if the pipe wall is
semipermeable. A mass transfer coefficient is used to model the loss rate, and external
bulk concentration i specified to define the driving force.

WALL MASS TRANSFER

For each species, enter a Mass transfer coefficient k,,,;; . (SI unit: m/s). The default is
0 m/s. For each species, select an option from the list (when available) or define the
Bulk concentration cp,;, (ST unit: mol/ms). The default is 0 mol/ms.

Concentration

The Concentration node adds a point condition for the species concentration. For

example, a ¢ = ¢ condition specifies the concentration of species c.

CONCENTRATION
Specify the Concentration c;;,. (SI unit: mol/(ms-s)) for each species. Enter a value or

expression in the field for each species. The default is 0 mol/ (ms-s).

CONSTRAINT SETTINGS
To display this section, click the Show More Options button ("= ) and select Advanced
Physics Options in the Show More Options dialog box.

Mass Outflow

Use the Mass Outflow node to define species mass outflow. Mathematically this is
defined so that convection is the sole contribution to species mass transfer. Normally

this constitutes a well posed condition for all outflows.

THE TRANSPORT OF DILUTED SPECIES IN PIPES INTERFACE
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The Reacting Pipe Flow Interface

The Reacting Pipe Flow (rpfl) interface (5. ), found under the Chemical Species
Transport branch ( ¢:# ) when adding a physics interface, is a multiphysics interface that
combines the three physics interfaces: Pipe Flow, Heat Transfer in Pipes, and Transport
of Diluted Species in Pipes. The physics interface approximates the flow profiles in
pipes and channels by a 1D assumption on lines in 2D and 3D. Depending on

additional add-on products, multiple species can be modeled.

When this physics interface is added, these default nodes are also added to the Model
Builder — Fluid, Pipe Properties, Temperature, Pressure, Concentration, and Initial Values.
Then, from the Physics toolbar, add other nodes that implement, for example,

boundary conditions and volume forces. You can also right-click Reacting Pipe Flow to

select physics features from the context menu.

SETTINGS

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers, and

underscores (_) are permitted in the Name field. The first character must be a letter.
The default Name (for the first physics interface in the model) is rpfl.

FLUID MODEL

Select a Fluid model — Newtonian (the default), Power law, Bingham, or Herschel-Bulkley.

PHYSICAL MODEL

Enter a Reference pressure level p,.¢ (SI unit: Pa). The default value is 1[atm].

DEPENDENT VARIABLES
This physics interface defines these dependent variables (fields). If required, edit the

name, but dependent variables must be unique within a model:

* Pressure p (SI unit: Pa)

* Tangential velocity u (SI unit: m/s)
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e Temperature T (SI unit: K)

* Concentration ¢ (SI unit: mol/ms)

DISCRETIZATION

Use this section to change the discretization order for the dependent variables.

e The Pipe Flow Interface
e The Heat Transfer in Pipes Interface
@l ¢ The Transport of Diluted Species in Pipes Interface

* Edge, Boundary, Point, and Pair Nodes for the Reacting Pipe Flow
Interface

Edge, Boundary, Point, and Pair Nodes for the Reacting Pipe Flow
Interface

The Reacting Pipe Flow Interface has these boundary, edge, point, and pair nodes
available from the Physics ribbon toolbar (Windows users), Physics context menu (Mac
or Linux users), or right-click to access the context menu (all users).

In general, to add a node, go to the Physics toolbar, no matter what
'g' operating system you are using. Subnodes are available by clicking the

parent node and selecting it from the Attributes menu.

These nodes are described in this section:

e Initial Values * Fluid Properties
* Convection and Diffusion * DPipe Properties
e Fluid

THE REACTING PIPE FLOW INTERFACE
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These nodes are described for the Pipe Flow interface (listed in alphabetical order):

* Bend e The Nonisothermal Pipe Flow
» Contraction/Expansion Interface

e Inlet * Pressure

* No Flow e Pump

e Outlet * T-Junction

e Phase Fractions e Valve

¢ Volume Force

These nodes are described for the Heat Transfer in Pipes interface (listed in
alphabetical order):

¢ External Film Resistance ¢ Internal Film Resistance
e Heat Outflow e Temperature

¢ Heat Source * Wall Heat Transfer

e Heat Transfer e Wall Layer

These nodes are described for the Transport of Diluted Species in Pipes interface
(listed in alphabetical order):

¢ Concentration

e Mass Outflow

* Reactions

e Wall Mass Transfer

In the COMSOL Multiphysics Reference Manual see Table 2-4 for links
to common sections and Table 2-5 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

Pipe Properties

The Pipe Properties node is used to define the pipe shape and flow resistance.
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SHAPE
The Pipe Shape settings are the same as for the Pipe Properties node described for the

Pipe Flow interface.

FLOW RESISTANCE
The Friction model is User defined by default. Enter a value or expression for the Darcy

friction factor /) (dimensionless). The default is 0.

Initial Values

The Initial Values node adds initial values for the pressure, tangential velocity,
temperature, and concentration that can serve as an initial condition for a transient

simulation or as an initial guess for a nonlinear solver.

INITIAL VALUES

Enter values or expressions for the initial value of the:

* Pressure p (SI unit: Pa). The default is 101325 Pa.
* Tangential velocity u (SI unit: m/s). The default is 0 m/s.
* Temperature T (SI unit: K). The default is 293.15 K.

* Concentration c (SI unit: mol/ms). The default is 0 mol/ms.

Fluid

Use the Fluid node to define the density, dynamic viscosity, and heat convection and

conduction properties.

FLUID PROPERTIES
The default Density o (SI unit: kg/m3) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity £ (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and the shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick,

such as oil, have a higher viscosity.

DIFFUSION COEFFICIENT
Enter a value or expression for D, (SI unit: mz/s). The default is 1 x 10™ m2/s.

THE REACTING PIPE FLOW INTERFACE ‘ 97



DISPERSION

Select a Dispersion model — User defined (the default), Taylor (laminar, circular cross
section), or Taylor (turbulent, circular cross section). For User defined, enter a value or
expression for the Dispersion coefficient Dpy (SI unit: mz/s). The defaultis 0 mz/s. For
detailed information about dispersion, see the theory section Dispersion.

HEAT CONVECTION AND CONDUCTION
The default Heat capacity at constant pressure C,, (SI unit: ] /(kg-K)), Ratio of specific
heats 7 (dimensionless), and Thermal conductivity 2 (SI unit: W/(m-K)) all use values

From material. For User defined enter different values or expressions.

Fluid Properties

The Fluid Properties node adds the momentum equations solved by the physics
interface, except for volume forces which are added by the Volume Force feature. The

node also provides an interface for defining the fluid properties of the fluid.

FLUID PROPERTIES
The default Density o (SI unit: kg/m3) is User defined and is 1 x 103 kg/ms.

The fluid model is selected as non-Newtonian, enter a value or expression for the more
parameters like Yield stress 7, (SI unit: Pa) and Plastic viscosity 1, (SI unit: Pa-s).

Convection and Diffusion

Use the Convection and Diffusion node to define the fluid properties, velocity, diffusion

coefficient, and dispersion model. This node is present by default.

FLUID PROPERTIES
The default Density o (SI unit: kg/ms) is User defined and is 1 x 103 kg/ms.

Enter a value or expression for the Yield stress 7, (SI unit: Pa) and Plastic viscosity

(SI unit: Pa-s). The defaults are 0 Pa and 0 Pa-s, respectively.

VELOCITY

No user selection is required for the Tangential velocity u.

DIFFUSION COEFFICIENT

Enter a value or expression for the diffusion coefficient D,, (SI unit: m? /s). The default
is1x107 mz/s.
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DISPERSION

Sclect a Dispersion model — User defined (the default) or Fan (laminar, circular cross
section). For User defined, enter a value or expression for the Dispersion coefficient Dy
(SI unit: mz/s). The default is 0. For detailed information about dispersion, see the
theory section Dispersion.
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Theory for the Transport of Diluted
Species in Pipes Interface

The Transport of Diluted Species in Pipes Interface theory is described in this section.
This physics interface solves a mass balance equation for pipes in order to compute the
concentration distribution of a solute in a dilute solution, taking the flow velocity as

input.

MASS CONSERVATION EQUATION
The mass transport equation for a diluted species z an incompressible fluid flowing in
a pipe is:
ac;
AE +Au-Ve; = V- (AD; + Dp ;)Vc;) +A2Rik + ZRwall, in (4-1)
k k

where A (ST unit: m? ) is the cross section area available for flow, ¢; (SI unit: mol/ ms)
is the diluted species concentration, and wu a velocity field. Further, D; (ST unit: m? /s)
is the species diffusion coefficient and Dp ; (SI unit: m? /s) is the species dispersion
coefficient. The second term on the right hand side, R;;, (SI unit: mol/(m3~s)),
corresponds a source or sink due to chemical reaction number & for species i. Finally,
Ryyqi1,ir (ST unit: mol/(m:s)), is a source term due to mass transfer contribution k&
through the pipe wall.

For information about tangential velocity in pipe flow, see Theory for the
lﬂ Pipe Flow Interface.

Dispersion
The Transport of Diluted Species in Pipes interface can automatically calculate the axial

dispersion of species transported in a solvent stream.

For laminar flow in circular straight pipes, the total dispersion is given by the sum of
molecular diffusion, D; (SI unit: m“/s), and the effect of the velocity profile causing
some fractions of an initial plane of fluid in the pipe to move faster than others.
COMSOL Multiphysics uses the Taylor (Ref. 22) correlation for this second
contribution, Dp ; (SI unit: mz/s):
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2,2
u'd

Di = 192D, 42
This expression is valid if:

L ud

ke 0.043 (4-3)

l

where d is the pipe diameter and L a characteristic pipe length. For turbulent
conditions, Taylor (Ref. 23) suggests:

_ 1019, o
Dp; = 10.12u£- (4-4)

For non-Newtonian fluids in the laminar regime, Fan (Ref. 24) extended the analysis

of Taylor:
2,2
d
Dp; = k- (4-5)
Di =" 4D,
with & for Power-law fluids given by:
L (4-6)

S TR T
and % for Bingham plastic fluids:

3 44 16,2 4 285 36 87 298 1,10 .8
(5-3300+ 1390 + 00 1306 - 306 + 00~ 5506 + 500~ 0glnoy)
k= " " (4-7)
2(3+2¢9+0g) (1-9p)

The parameter ¢ is

=10

= 4-8
where R is the pipe radius and 7 is the radius of the plug flow region in the plastic

flow, defined as

2L7p
r =
0 Ap

4-9)

This can be rewritten as
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4
b = ~—Bm (4-10)
d[v'p|

where the tangential pressure gradient is calculated by the Pipe Flow interface.

STABILIZATION OF THE MASS TRANSFER EQUATION

The transport equation in the Transport of Diluted Species in Pipes node is
numerically stabilized.

Numerical Stabilization in the COMSOL Multiphysics Reference
@ Manunl
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Acoustics Interfaces

This module has extra functionality for simulating acoustics in pipe networks. You
can access this functionality under the Acoustics>Pipe Acoustics branch ( (1)) ) when
adding a physics interface. The documentation of the Pipe Acoustics interfaces is
found in the Acoustics Module User’s Guide in:

* The Pipe Acoustics Frequency Domain and Transient Interfaces
e Theory for the Pipe Acoustics Interfaces
In the Acoustics Module User’s Guide you also find information about all the other

acoustics physics interfaces as well as about the multiphysics coupling to Pressure
Acoustics.
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Pipe Mechanics

This module has extra functionality for computing displacements, rotations,
stresses, strains in pipes using The Pipe Mechanics Interface, which you find under
the Structural Mechanics branch (£=2) when adding a physics interface.

The documentation of The Pipe Mechanics Interface is found in the Structural
Mechanics Module documentation, which is supplied with the Pipe Flow Module
(irrespectively of whether a separate Structural Mechanics Module license is

purchased).
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Multiphysics Couplings

This chapter contains a description of all the multiphysics coupling features of the
Pipe Flow Module.
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Coupling Features

The Pipe Flow Module contains the following Multiphysics Coupling features:

¢ Pipe Connection

* Acoustic-Pipe Acoustic Connection
¢ Structure-Pipe Connection

¢ Fluid-Pipe Interaction

The couplings features are described below.

Pipe Connection

You can easily couple Pipe Flow Interface with Single-Phase Flow interfaces using
multiphysics coupling feature Pipe Connection (E_—’]l; ). The Pipe Connection node is only
available with some COMSOL products (see https://www.comsol.com/products/

specifications /).

The Pipe Connection multiphysics coupling couples a 1D pipe segment modeled with

the Pipe Flow interface with a 3D single phase flow body.

BOUNDARY SELECTION, FLUID
Select the boundary that corresponds to the inlet/outlet of the 3D model coupled to

Pipe Flow interface.

POINT SELECTION, PIPE

Select the point that corresponds to the inlet/outlet of the pipe model coupled to the
3D fluid flow domain.

CONNECTION SETTINGS
There is an automatic search for possible adjacent geometrical objects. If you want to
modify the selections, select the Manual control of selections check box. If you clear it,

the selections will be replaced by the automatic ones.

Note that, you can connect only one pipe segment to 2D surface that comprises an
orifice in a 3D body.
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The connection ensure continuity in mass flux and pressure across the connection,

regardless of flow direction.

Convective Flow in o Heat Exchanger Plate: Application Library path
[lI[l Pipe_Flow_Module/Tutorials/heat_exchanger_plate

Acoustic-Pipe Acoustic Connection

The Acoustic-Pipe Acoustic Connection multiphysics coupling ((7j) ) is used to couple the
Pipe Acoustics interface to the Pressure Acoustics interface. The Acoustic-Pipe Acoustic
Connection multiphysics coupling is only available with some COMSOL products (see

https: / /www.comsol.com/products /specifications /).

The documentation of Acoustic-Pipe Acoustic Connection multiphysics coupling is

found in the Acoustic Module documentation.

Acoustics of & Pipe System with 3D Bend and Junction: Application
Library path Acoustics_Module/Tutorials,_Pipe_Acoustics/
[lI[l acoustics_pipe_system

Probe Tube Microphone: Application Library path Acoustics_Module/

Tutorials,_Pipe_Acoustics/probe_tube_microphone

Fluid-Pipe Interaction

The Fluid-Pipe Interaction (=g ) multiphysics node provides a way to transfer fluid loads
from the Pipe Flow interface to the Pipe Mechanics interface.

The documentation of Fluid-Pipe Interaction multiphysics coupling is found in the

Structural Mechanics Module documentation.

Structure-Pipe Connection

The Structure-Pipe Connection ( (=) multiphysics node is used to couple the structural
mechanics interfaces to the Pipe Mechanics interface. The Structure-Pipe Connection
multiphysics coupling is only available with some COMSOL products (see https://

www.comsol.com/products/specifications /).

COUPLING FEATURES
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The documentation of Structure-Pipe Connection multiphysics coupling is found in

the Structural Mechanics Module documentation.
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